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THE CONSTITUTION OF INDIA

PREAMBLE

1WE, THE PEOPLE OF INDIA, having solemnly resolved to constitute India into a SOVEREIGN 

SOCIALIST SECULAR DEMOCRATIC REPUBLIC and to secure to all its citizens :

JUSTICE, social, economic and political;

LIBERTY of thought, expression, belief, faith and worship;

EQUALITY of status and of opportunity; and to promote among them all 

2 FRATERNITY assuring the dignity of the individual and the unity and integrity of the Nation; 

IN OUR CONSTITUENT ASSEMBLY this twenty-sixth day of November, 1949, do HEREBY ADOPT, 

ENACT AND GIVE TO OURSELVES THIS CONSTITUTION.

THE CONSTITUTION OF INDIA

Chapter IV A

FUNDAMENTAL DUTIES

ARTICLE 51A

Fundamental Duties - It shall be the duty of every citizen of India-

(a) to abide by the Constitution and respect its ideals and institutions, the National Flag and the National 
Anthem;

(b) to cherish and follow the noble ideals which inspired our national struggle for freedom;

(c) to uphold and protect the sovereignty, unity and integrity of India;

(d) to defend the country and render national service when called upon to do so;

(e) to promote harmony and the spirit of common brotherhood amongst all the people of India transcending 
religious, linguistic and regional or sectional diversities; to renounce practices derogatory to the dignity of 
women;

(f) to value and preserve the rich heritage of our composite culture;

(g) to protect and improve the natural environment including forests, lakes, rivers, wild life and to have 
compassion for living creatures;

(h) to develop the scientific temper, humanism and the spirit of inquiry and reform;

(i) to safeguard public property and to abjure violence;

(j) to strive towards excellence in all spheres of individual and collective activity so that the nation constantly 
rises to higher levels of endeavour and achievement;

1(k) to provide opportunities for education to his/her child or, as the case may be, ward between age of 6 and 14 
years.

1. Subs, by the Constitution (Forty-Second Amendment) Act. 1976, sec. 2, for "Sovereign Democratic Republic” (w.e.f. 3.1.1977)

2. Subs, by the Constitution (Forty-Second Amendment) Act. 1976, sec. 2, for "unity of the Nation” (w.e.f. 3.1.1977)

1. Subs. by the Constitution (Eighty - Sixth Amendment) Act, 2002 



As the Information Technology (IT) industry evolves to meet the technology demands of today's 

workplace, different challenges are arising and IT professionals are striving to meet them. IT 

has created a revolution in each and every field. CBSE has introduced IT course in class-XI 

(Level-3) and XII (Level-4), aligned with National Skill Qualification Framework (NSQF), an 

initiative of Government of India to set common principles and guidelines for a nationally 

recognized qualification system covering the schools, colleges and universities.

This Students Handbook titled "Web Applications" for class - XII prepared by CBSE for the 

benefit of the students for a complex understanding of the ways in which the web functions, and 

of the skills needed to generate web content, is essential for successful participation in nearly all 

professions.

A special care has been taken to align the subject with National Occupation Standards (NOS) 

which are competency based standards identified by the IT industry to train Sr. Secondary 

students in knowledge and skills that equip students to perform effectively with confidence.

Relevant examples in programming, pictorial illustrations, tables and simplified concepts help 

the students to learn with ease and comfort way.

This book is authored by competent educationists in the field of Information Technology under 

supervision of CBSE with focus on helping the students to learn without any difficulty and use 

this book as a tool for easy learning.

I congratulate everyone who is associated in developing this book which is a very useful 

resource for the benefit of the students.

Chairman, CBSE

Preface
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Chapter - 1: Movie Editing Tools 
 

Learning Objectives: 
After Studying this unit the students will be able to:  

 Understand the concept of Movie Editing Tool  

 Get familiarize with multiple Movie Editing Tools  

 Get depth knowledge of window movie maker tool  

 Get familiarize with Interface Components  

 Can perform splitting and combining of various Clips  

 Can add titles and publish movie in Window Movie Maker  

Introduction 

There are many free video editing software programs available for download today, but not all of 
them are good. Many programs simply don't do what the manufacturers say that they will do, 
and others don't provide enough - or any support. Of course, most free software does not 
include the same level or quality of support that you would expect to find with software that you 
purchase commercially.  

Movie Editing tools are editing software and we can also say them as application software which 
handles the post – Production video editing of digital video sequences on a computer non-linear 
editing system (NLE).  

Hardware: Computer system  

Software: Window Movie maker tool  

1.1 Movie Editing Tools  

 There are many free video editing software programs available for download today, but not 
all of them are good. Many programs simply don't do what the manufacturers say that they 
will do, and others don't provide enough - or any support.  

 Of course, most free software does not include the same level or quality of support that 
you would expect to find with software that you purchase commercially.  

 While it is true that you get what you pay for, there really are some good free video editing 
software available out there. Here are the top frequently used, that we have found: 
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 Windows Movie Maker 2.6: The first release of Windows Movie Maker was included with 
Windows ME in 2000, but it was not available in Windows 2000, which was released 
months before Windows ME.  

 Version 1.1 was included in Windows XP a year later, and included support for creating 
DV AVI and WMV 8 files. Version 2.0 was released as a free update in November 2002, 
and added a number of new features. Version 2.1, a minor update, is included in Windows 
XP Service Pack 2. Windows XP Media Center Edition 2005 introduced a new version of 
Windows Movie Maker, 2.5, with more transitions and support for DVD burning.  

 Microsoft has made version 2.6 of Movie Maker available for download, and it runs on both 
Windows Vista and Windows 7. While advanced users are likely using a more 
sophisticated video editing program, there’s no denying that Movie Maker is an excellent, 
full-featured option for the average home user. Snapshot of window movie maker is 
depicted in Figure 1.1. 

 
Figure-1.1: Snapshot of Window Movie Maker 

VirtualDub: VirtualDub is a video capture/processing utility for 32-bit and 64-bit Windows 
platforms (98/ME/NT4/2000/XP/Vista/7), licensed under the GNU General Public License 
(GPL). It lacks the editing power of a general-purpose editor such as Adobe Premiere, but 
is streamlined for fast linear operations over video. It has batch-processing capabilities for 
processing large numbers of files and can be extended with third-party video filters. 
VirtualDub is mainly geared toward processing AVI files, although it can read (not write) 
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MPEG-1 and also handle sets of BMP images. In Figure 1.2 VirtualDub snapshot is 
represented. 

 
Figure-1.2: Snapshot of VirtualDub 

T@b ZS4 Video Editor: ZS4 Video Editor is free to download and use. It is video editing 
and compositing software which aims to provide media experts with a facility to combine a 
variety of media types (currently photos, videos and audio files) into one or more output 
files. In figure 1.3 snapshot of this editor is represented. 

 

Figure-1.3: Snapshot of T@b ZS4 Video Editor 
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Wax: Wax is a high performance and flexible video compositing and special effects 
software. The idea for Wax is to be very general purpose and flexible in video compositing 
and effects, so that you can compose your dream video sequence with ease every time. 
Wax can create 2D & 3D special effects and can work in two modes – as a standalone 
application which would appeal for home users/beginners, and as a “plug-in” to video 
editors/NLEs which would be more useful for professional editors. In figure 1.4 snapshot of 
this editor is represented. 

 
Figure-1.4: Snapshot of Wax. 5  

Cinefx Jashaka: Cinefx is an offline playback, editing, encoding, animation and visual 
effects tool based on the Jahshaka technology that allows you to create professional 
digital media on your desktop. Use the tools that hollywood uses to create blockbuster 
films and special effects. In figure 1.5 snapshot of this editor is represented. 
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Figure-1.5: Snapshot of Cinefx Jashaka  

Blender: Blender is the free open source 3D content creation suite, available for all major 
operating systems under the GNU General Public License. It is one of the powerful, multi-
use editing/compositing and modeling tool. This tool allows you to edit, create 3D 
graphics, sound effects, add special effects and much more. In figure 1.6 snapshot of this 
editor is represented. 

 

Figure-1.6: Snapshot of Blender 
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Avidemux: Avidemux is a free video editor designed for simple cutting, filtering and 
encoding tasks. It supports many file types, including AVI, DVD compatible MPEG files, 
MP4 and ASF, using a variety of codes. Tasks can be automated using projects, job 
queue and powerful scripting. In figure 1.7 snapshot of this editor is represented. 

 

Figure-1.7: Snapshot of Avidemux 7  

MovieStorm: Moviestorm is the complete 3D movie making software application for all 
abilities. Whether your movie interest is cartoons, crime, music, horror etc., you can create 
awesome animation effects using this software. In figure 1.8 snapshot of this editor is 
represented. 

 

Figure-1.8: Snapshot of MovieStorm 
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Movica: Movica is just a graphical user interface that uses some fine programs to edit 
movie files. A great deal of emphasis has been placed on keyboard shortcuts to make the 
job of editing easier. Basically, it is meant for editing the kind of movies that VirtualDub 
won’t. V-Dub is primarily an AVI editor, Movica will work on .wmv, .flv, .rm and .mpg files. 
This makes it more versatile than Virtualdub. In figure 1.9 snapshot of this editor is 
represented. 

 

Figure-1.9: Snapshot of Movica  

VideoSpin: VideoSpin, free editor based on Studio, does a pretty darn good job 
compared with most free video tools. It doesn’t match the qualities of paid software's but 
perform basic editing and output movies pretty easily. In figure 1.10 snapshot of this editor 
is represented. 

 
Figure-1.10: Snapshot of Video Spin  
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AVIedit: It is a great tool to work with .AVI files. Regardless of small executable size, this 
avi editor offers you unlimited power of digital video processing. AVI edit allows you to join 
and split avi files, extract frames and do whatever you want. You can capture video by 
number of ways, 9 including one-frame-per-minute (web camera) option, workaround 
annoying 2 GB file size limit, send your videos to printer, heavy compress it and post to 
your webpage. In figure 1.11 snapshot of this editor is represented. 

 

Figure-1.11: Snapshot of AVIedit  

StoryBoard Pro Software: Atomic Learning’s FREE Video StoryBoard Pro is designed to 
give teachers, students, and home movie makers a tool to plan ahead when creating video 
projects. It features the ability to enter shot titles and descriptions, complete with planned 
lengths and edited order, indicate shot types: video, still, audio, music, or titles and much 
more. In figure 1.12 snapshot of this editor is represented. 

 
Figure-1.12: Snapshot of StoryBoard Pro Software  
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AVI Trimmer: The AVI Trimmer is a free video editor for fast and lossless AVI editing. 
This freeware AVI editor is small, smart, easy to use and involves no encoding/decoding 
processes. No video / audio degradation and out of sync problem arises after editing. All 
AVI file types of any size and video / audio content are supported. In figure 1.13 snapshot 
of this editor is represented. 

 
Figure-1.13: Snapshot of AVI Trimmer 

Zwei-Stien Video Editor: Zwei-Stein 3.01 is a freeware non-linear, non-destructive video 
compositing and editing system which offers many advanced features unavailable 
elsewhere. With Zwei-Stein you can edit up to 256 video, audio and still image clips, each 
with up to 64 effects chained serially. Cropping, panning and custom effects are easy with 
automatic key frames. In figure 1.14 snapshot of this editor is represented.  

 
Figure-1.14: Snapshot of Zwei-Stien Video Editor 
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DVDVideoSoft Free: A pretty basic software to edit video and audio files. Free Studio is a 
single package which bundles all free software from DVDVideoSoft to work with DVD, 
video and audio files. With this free software you can convert video and audio files 
between different formats and to iPod, PSP, iPhone, BlackBerry and other portable 
devices; burn and rip DVDs and audio CDs; upload and download videos and music to 
your computer, iPod, PSP, iPhone and BlackBerry; perform basic editing of audio and 
video files. In figure 1.15 snapshot of this editor is represented. 

 

Figure-1.15: Snapshot of DVDVideoSoft Free  

AVITricks Video Editor: AviTricks is a non-linear, non-destructive AVI video editor with 
real-time preview. It makes cutting and joining footage easy and includes a wide range of 
built-in adjustable effects that can be used separately or in combination. (Effects include 
dissolves, mirror image, sepia, iris effects, fades, TV-shop and many more.) Besides the 
preview screen, the video you are working on is also represented clearly 12 and 
graphically on a timeline and a tree-structure. Both of these fields are active and easy to 
work. In figure 1.16 snapshot of this editor is represented. 

 
Figure-1.16: Snapshot of AVITricks Video Editor  
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DVD Knife: DVD Knife is a simple tool for extracting DVD clips from your DVD’s. The clips 
will be stored in VOB format only. This is the simplest and fastest tool in its category which 
has ability to extract long VOB clips in few seconds. It's so simple that only three steps can 
extract the clip i.e. “Select start” – “Select end” – “Save”. So get your favorite movie or film 
scenes stored separately now. It is compatible with Windows XP. I hope this little free tool 
will come for Vista or 7 in the future. In figure 1.17 snapshot of this editor is represented. 

 
Figure-1.17: Snapshot of DVD Knife  

Mewa Film: It is a non-linear editing tool, called montage (this name might change) where 
video files are shown as a sequence of images layed off horizontally. The video files can 
then be assembled and cutted using intuitive actions as “drag and drop” and “rubber band 
selection”. In figure 1.18 snapshot of this editor is represented. 

 
Figure-1.18: Snapshot of Mewa Film  
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 Assessment: 
 Answer the following questions: 

Q1. Differentiate between the features of virtual dub, wax, movica and moviestorm. 

Q2.  Explain the non linear editing tool which does horizontal layering. 

Q3.  Which tool should be used for .avi files? 

Q4.  Explain two non destructive and non linear tools for video editing 

1.2 Familiarization of Interface Components 

Windows Movie Maker is a feature of Windows Vista that enables us to create home 
movies and slide shows on our computer, complete with professional-looking titles, 
transitions, effects, music, and even narration. We can use Windows Movie Maker to 
publish our movie and share it with our friends and family.  

Understanding the Windows Movie Maker Tools  

Windows Movie Maker is divided into three main areas: the panes, the 
storyboard/timeline, and the preview monitor is mentioned in figure 1.19. 

 
Figure-1.19: The Main Areas of Windows Movie Maker  

About the Panes  

Windows Movie Maker provides several different panes that are:  

 The Tasks pane lists the common tasks that may be needed to perform while making a 
movie, including importing files, editing, and publishing your movie.  
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 The Collections pane displays our collection folders, which contain clips. The collection 
folders appear in the Collections pane on the left, and the clips in the selected 
collection folder are displayed in the Contents pane on the right. The following picture 
shows the Collections pane in figure 1.20:  

 
Figure-1.20: Collections Pane  

 The Contents pane shows clips, effects, or transitions that are working with while 
creating our movie, depending on the view being worked with. We can change the 
view to show thumbnails or details.  

We can drag clips, transitions, or effects from the Contents pane or a collection from the 
Collections pane to the storyboard/timeline for your current project. We can also drag clips 
to the preview monitor to play them. If you make changes to a clip, those changes are only 
reflected in the current project; they do not affect the source file.  

About the Storyboard and Timeline  

The area where the project is created and edited is displayed in two views, the storyboard 
and the timeline. We can switch between these two views while making a movie.  

 Storyboard. The storyboard is the default view in Windows Movie Maker. We can use 
the storyboard to look at the sequence or ordering of the clips in your project and 
easily rearrange them, if necessary. This view also let us see any video effects or 
video transitions that have been added. Audio clips that have added to a project are 
not displayed on the storyboard, but we can see them in the timeline view. The 
following picture shows the storyboard view in Windows Movie Maker (figure 1.21):  
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Figure-1.21: Storyboard View  

Timeline: The timeline view provides a more detailed view of our movie project and 
allows us to make finer edits. Using this timeline view, we can:-  

1) Trim video clips, adjust the duration of transitions between clips, and view the 
audio track.  

2) Review or modify the timing of clips in your project. Use the timeline buttons to 
switch to storyboard view, zoom in or out on details of your project, narrate the 
timeline, or adjust the audio levels.  

The following picture shows the timeline view in Windows Movie Maker i.e. figure 1.22: 

 
Figure-1.22: Timeline View 

About the Preview Monitor  

The preview monitor enables us to view individual clips or an entire project. By using the 
preview monitor, we can preview our project before publishing it as a movie. We can use 
the buttons underneath the preview monitor to play or pause a clip, or to advance or 
rewind a clip frame-by-frame. The Split button allows us to split a clip into two parts at the 
point displayed in the preview monitor.  

The preview monitor can be made larger or smaller by clicking View, pointing to Preview 
Monitor Size, and choosing a size. The window can be dragged to make it larger or 
smaller.  

 Assessment: 
 Answer the following questions: 

Q1. Which is the default view in movie maker? 

Q2.  What are the functions of various movie panes of the windows movie maker? 
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1.3 Importing Pictures, Audio and Video Clips Pictures into Windows Movie 
Maker  

We can import files with the following file name extensions into Windows Movie Maker to 
use in your project:  

 Video files: .asf, .avi, .dvr-ms, .m1v, .mp2, .mp2v, .mpe, .mpeg, .mpg, .mpv2, .wm, 
and wmv  

 Audio files: .aif, .aifc, .aiff .asf, .au, .mp2, .mp3, .mpa, .snd, .wav, and .wma  

 Picture files: .bmp, .dib, .emf, .gif, .jfif, .jpe, .jpeg, .jpg, .png, .tif, .tiff, and .wmf  

We can also import files into Windows Movie Maker that have a different extension from 
the ones listed above, but not all file types will work when you we try to use them to make 
a movie. 

Microsoft Recorded TV Show files (with a .dvr-ms file name extension) that are not 
protected using digital rights management can be imported into Windows Movie Maker if 
your computer is running Windows Vista Home Premium or Windows VistaUltimate.  

Steps to Import Files into Windows Movie Maker  

1)  Click File, and then click Import Media Items.  

2) Navigate to the location that contains the digital media files you want to import, and 
then click Import.  

Special Tips  

 We can import several video clips at once. For consecutive clips, click the first video 
clip in the list, press and hold down the SHIFT key, and then click the last clip in the 
list. For video clips that are not consecutive, press and hold down the CTRL key, and 
then click each clip that you want to import into Windows Movie Maker.  

 We can also import video files and pictures by dragging the files from Windows Photo 
Gallery into Windows Movie Maker.  

Examples: One by one picture representation of steps are mentioned in figure 1.23 
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Figure-1.23: Snapshot of Importing Video 

 Assessment: 
 Answer the following questions: 

Q1.  What does .mp2 and .mp3 stand for? 

Q2.  What are the commonly used file extensions for images? 

Q3.  Can we import more than one clip at a time? 

Q4.  What does .jpeg stand for? 

1.4  Splitting, Joining and Trimming Movie Clips  

After the files are imported into Windows Movie Maker, we can start the main part of 
moviemaking - editing. Using Windows Movie Maker, where we can edit clips in a variety 
of different ways. We can split a long clip into two shorter clips, combine two clips into a 
single clip, trim the beginning or ending of a clip, and even create new clips.  

Split and Combine Clips  

We can manually split video and audio clips into smaller clips to make your clips easier to 
work with. 

We can combine contiguous video clips on the storyboard or in the Contents pane (before 
adding the clip or clips to the storyboard/timeline).  
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Steps to Split a Clip:  

1) In the Contents pane or on the storyboard/timeline, click the video or audio clip that 
need to be split.  

2)  Under the preview monitor, click the Play button.  

3)  When the clip reaches a point near the place you want to split the clip, click Pause.  

4)  Under the preview monitor, use the playback controls to find the point where we want 
to split the clip.  

5)  Under the preview monitor, click the Split button.  

Tip: The playback indicator can be dragged on the seek bar to the exact spot where you 
want to split the clip.  

To Combine Clips  

1) In the Contents pane or on the storyboard, hold down the CTRL key, and then click 
the contiguous clips which need to be combined.  

2)  Click Clip, and then click Combine.  

The name and property information of the first clip in the group is used for the new clip and 
the time is adjusted accordingly.  

Tip: We can combine more than two clips at a time as long as they are consecutive. To 
select multiple clips, click the first clip, press and hold down the SHIFT key, and then click 
the last clip.  

Trim (Hide) Parts of a Video Clip  

When a clip is to be trimmed, a new start and/or end trim point is made. The start trim 
point determines when the clip will begin to play, and the end trim point determines when 
the clip will stop playing in our project and final movie. When we trim a clip, the trimmed 
part of the clip is not actually removed from the source file; it's just hidden so the trimmed 
part doesn't appear in our project or published movie as mentioned in figure 1.24. 

 
Figure-1.24: A Trimmed Video Clip with the Trimmed Part Highlighted  
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Steps to trim a video clip  

1)  While in the storyboard view, click View, and then click Timeline.  

2)  On the timeline, click the clip that wished to be trim.  

3)  Use the playback controls under the preview monitor to find the point where you want 
to trim the clip.  

4)  Do the following:  

 When the playback indicator is at the point where we want the selected video or 
audio clip to start playing back, click Clip, and then click Trim Beginning.  

 When the playback indicator is at the point where we want the selected video or 
audio clip to stop playing back, click Clip, and then click Trim End.  

Notes: 

 We can also drag the trim handles on a clip to set the start and end trim points. Trim 
handles appear as small black triangles at the beginning and end of a clip after we 
click the clip on the timeline. When you hold your pointer over a trim handle, the 
pointer changes to a red double-headed arrow. Drag a trim handle to set the new start 
or end point of the clip as shown in figure 1.25.  

 
Figure-1.25: Trimming a Clip with the Trim Handle  

 The Zoom Timeline In button one is used to see clips more clearly on the timeline. The 
Zoom Timeline In button appears on the timeline toolbar as a magnifying glass with a 
plus sign (+) in it.  

To Undo a Trimmed Clip  

1)  While being in storyboard view, click View, and then click Timeline.  

2)  Click the trimmed clip on the timeline, click Clip, and then click Clear Trim Points.  
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Create Clips  

We can also create several smaller, more manageable clips from a single existing video 
clip to make it easier to work with the project. Windows Movie Maker creates clips in 
different ways, depending on the clip's source. If the source clip is from a digital video (DV) 
camera, Windows Movie Maker creates clips that are based on the time stamps that the 
DV camera inserts when the source video is originally recorded, as well as significant 
frame changes in the video.  

1)  In the Contents pane, select the video clip for which you want to create clips.  

2)  Click Tools, and then click Create Clips.  

Note:  

Clips can be created automatically for Windows Media Video (WMV) files and Audio-Video 
Interleaved (AVI) video files that use the DV codec. For other video file formats, clips 
cannot always be created automatically using clip creation, so the video file appears as 
one large video clip in Windows Movie Maker. For these large video clips, split the clip 
manually to separate the large video clip into smaller clips.  

Examples:  

For example, if we have a video clip that has two different scenes, you might want to split 
the video clip at the point where the one scene ends and the other begins, and then insert 
a transition between the two clips in figure 1.26. 

 
Figure-1.26: A Video Clip that’s been Split into Two Clips  

Conversely, a file that was divided into smaller clips that can be combined. However, only 
contiguous clips cab be combined. "Contiguous" means that the start time of the second 
clip immediately follows the end time of the first clip. For example, if we have a video or 
audio file that was divided into clips when it was imported into Windows Movie Maker, and 
the clips are named Clip 1, Clip 2, and Clip 3, in that order, we could combine Clip 1 and 
Clip 2, or Clip 2 and Clip 3, but we cannot combine Clip 1 and Clip 3.  
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 Exercise: 
Q.1  Perform trimming on your video clip as follows: 

 Click view, and then click timeline (all in storyboard view) 

 On the timeline, click the clip that you want to trim 

 Use the playback controls under the preview monitor to find the point where you 
want to trim the clip. 

 When the playback indicator is at the point where we want the selected video or 
Audio clip to start playing back, click clip, and then click trim beginning. When the 
playback indicator is at the point where we want the selected video or audio clip 
to stop playing back, click clip, and then click trim end. 

 Assessment: 
 Answer the following questions: 

Q1.  What are contiguous clips? 

Q2.  How is a clip split? 

Q3.  What do you mean by trimming a clip? 

Q4.  Can you undo the trimming changes? 

1.5 Adding Titles in Windows Movie Maker  

With Windows Movie Maker, we can add a title, your name, the date, credits, and other 
text to your movie. For example, you might want to add a title to introduce a person or 
scene that appears in your movie.  
You can add title text to various places in your movie: at the beginning or end, before or 
after a clip, or overlaying a clip. The title plays for the specified amount of time, either on 
the screen by itself or overlaying the video as it plays, and then the title disappears and 
the video clip or picture continues.  

The following picture shows in figure 1.27, a project with a title that appears before a video 
clip: 

 
Figure-1.27: Beginning Title on the Timeline  
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The following picture shows i.e. figure 1.28 a project with a title that overlays a video clip 
as the clip plays in: 

 
Figure-1.28: Overlay Title on the Timeline  

The following picture i.e. figure 1.29 shows a project with credits that appear at the end of 
the project: 

 

Figure-1.29: Credits on the Timeline  

 

1)  Click that location on the storyboard/timeline where title or credit is to be inserted.  

2)  Click Tools, and then click Titles and Credits.  

3)  Click the link that corresponds to location where title or credit is to be inserted..  

4)  In the Enter text for title box, type the text that you want to appear as the title or credit.  

 After you type the text, the monitor displays the default animation and format for the 
title or credit need to be inserted. 

5)  To change the title animation, click Change the title animation, and select a title 
animation from the list.  

6)  To change the font and color for your title, click Change the text font and color, and 
then choose the font, font color, formatting, background color, transparency, font size, 
and position of the title to your liking.  

7)  Click Add Title.  



 22 

Steps to Edit an Existing Title  

1)  On the storyboard/timeline, click the title need to be edited.  

2)  Click Edit, and then click Edit Title.  

3)  Make the changes, and then click Add Title.  

Steps to Change the Title Duration 

1)  To make sure that you are in timeline view, click the View menu, and then click 
Timeline.  

2)  Select the title whose duration you want to change.  

3)  Do the following:  

 To extend the playback duration of the title, drag the end trim handle toward the 
end of the timeline.  

 To reduce the playback duration of the title, drag the end trim handle toward the 
beginning of the timeline.  

Steps to Remove a Title  

1)  On the storyboard/timeline, click the title that need to be removed.  

2)  Click Edit, and then click Remove.  

Note: Trim handles appear as black triangles at the beginning and end of a clip. The 
pointer changes to a red double-headed arrow when we hold it over a trim handle.  

Examples: Once you click a button for the type of title you want you will be brought to a 
screen to add your text. Figure 1.30(a) represented a snapshot of screen appear enter text 
for title and figure 1.30(b) represented a snapshot of screen where we have to enter text 
for title 

 
Figure-1.30(a): Snapshot of Screen Appear Enter Text for Title 
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Figure-1.30(b): Snapshot of Screen we Enter Text for Title  

As you add the text you will have the opportunity to preview your titles in the preview 
screen. If you want to make a change to the way the title animation looks you can click on 
Change the title animation link under more options. Under more options is also where you 
can Change the text font and color. 

Exercise: 
Q1.  Edit the existing title as follows: 

 On the timeline, click the title that needs to be edited. 

 Click Edit, and then click Edit Title. 

 Make the changes, and then click Add Title. 

Assessment: 
Answer the following questions: 

Q1.  Explain the Steps needed to Change the Title Duration of your video. 

Q2.  How can you burn your movie into a CD? 

Q3.  How will you save your movie, once compiled? 

Q4.  How can the title be removed from the video? 

1.6 Publishing Movie in Windows Movie Maker  

After finishing working on a project, we can publish the project as a movie. A movie is a 
Windows Media file with a .wmv file name extension or an Audio-Video Interleaved (AVI) 
file with an .avi file name extension. This published movie in Windows Movie Maker can 
also be shared with others in a number of ways - through our computer, on a recordable 
CD, on a recordable DVD, as an attachment in an e-mail message, or on videotape in a 
DV camera.  
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Steps to Publish a Movie to your Computer  

1)  Click File, click Publish Movie.  

2)  Click This computer, and then click Next.  

3)  In the File name box, type a name for your movie.  

4)  In the Publish to box, choose where ever want to save the movie once it's published, 
and then click Next.  

5)  Choose the settings to be used to publish the movie, and then click Publish.  

6)  To watch the movie after it has been published, select the Play movie after clicking 
Finish check box.  

7)  Click Finish.  

Steps to Publish and Burn a Movie to DVD  

To publish and burn a movie to a DVD, you must have Windows DVD Maker, which is 
included in Windows Vista Ultimate and Windows Vista Home Premium. You also need a 
DVD burner.  

1)  Insert a blank recordable or rewritable DVD into your DVD burner.  

2)  Open a project in Windows Movie Maker.  

3)  Click File, and then click Publish Movie.  

4)  Click DVD, and then click Next. Windows DVD Maker opens.  

5)  Complete the steps to create a DVD using Windows DVD Maker. 

Steps to Publish and Burn a Movie to a Recordable CD  

1)  Insert a blank recordable CD or a rewriteable CD into your CD burner.  

2)  Click File, and then click Publish Movie.  

3)  Click Recordable CD, and then click Next.  

4)  In the File name box, type a name for your movie.  

5)  In the CD Name box, type a name for the CD, and then click Next.  

6)  Choose the settings to be used to publish the movie, and then click Publish.  

7)  To publish and burn the movie to another recordable CD, select the Publish this 
movie to another recordable CDcheck box, and then click Next. Replace the 
recordable CD with another recordable CD, and then repeat steps 4 through 6.  

Steps to Send a Movie as an E-mail Attachment in an E-mail Message  

1)  Click File, and then click Publish Movie.  

2)  Click E-mail, and then click Next.  
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3)  After the movie is published, do any of the following:  

 To play the movie in the default player before sending it, click Play the movie.  

 To save a local copy of the movie on your computer in addition to sending it as 
an e-mail attachment, click Save a copy of my movie on my computer, enter a 
movie file name in the File name box, and then click Save.  

4)  To attach the movie to an e-mail message, click Attach Movie.  

5)  In the default e-mail program, enter the e-mail address of the person to which movie 
need to be send, add any additional text to the body, and then send the message.  

Steps to Record a Movie to a Videotape in a Digital Video Camera  

1)  Switch your digital video (DV) camera on and verify that it is in playback mode (often 
labeled VCR on the camera).  

2)  Click File, and then click Publish Movie  

3)  Click Digital video camera, and then click Next. 

4)  If more than one digital video device powered on and detected by Windows Movie 
Maker, on the Choose a digital video camera page, choose the digital video device 
that contains the videotape to which the movie is recorded, and then click Next.  

5)  When we see the Cue your tape page, using the transport controls on our camera, 
rewind or fast-forward the tape to the point where the movie is to be recorded, and 
then click Next.  

 Warning: There should not be any overwriting a portion of the tape that contains 
recorded video.  

6)  To begin recording the movie back to tape, click Yes.  

Wait for the movie to be published and then recorded to the videotape. The time it 
takes to create and record the movie to tape depends on the length of the movie and 
the system resources on your computer. You can preview the movie in the LCD 
display of your DV camera as your movie is recorded to tape.  

7)  Click Finish.  

Steps to Change Where Movies are Temporarily Saved  

Windows Movie Maker uses a temporary file storage location in the following ways:  

 When we publish a movie, the audio or movie file is held in the temporary file location 
until the file is published.  

 When we record an audio narration, a temporary file is stored in the temporary file 
storage location, and then removed after the audio file is saved.  

 When we publish a movie that you want to attach to an e-mail message, a copy of the 
movie file is stored in the temporary file location until the movie is sent successfully.  
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 When we send a movie to a tape in a digital video (DV) camera, the temporary movie 
file that is created is stored in this location until the movie is recorded to the tape.  

We can change the default file storage location in Windows Movie Maker. For example, if 
we have a storage location that has more available disk space. If our hard disk has two 
partitions, we want to choose the drive that has more storage space.  

1)  Click Tools, and then click Options.  

2)  Click the General tab, and then in the Temporary storage box, choose the default 
location where temporary audio and movie files are to be saved temporarily.  

Steps to Avoid Including the Title, Author, Copyright, Rating, and Comments 
Information in the Published Movie File  

Always remember not to include information such as the title, author, copyright, rating, and 
comments in your published movie files so that our name and other metadata information 
is not displayed when someone else plays back our movie in a media player.  

To choose not to include metadata in your finished movie, do the following:  

1)  Click Tools, and then click Options.  

2)  Click the General tab, and then select or clear the Do not include the title, author, 
copyright, rating, and comments information in the published movie file check box, 
depending on whether we want personally identifiable information to be removed with 
the published movie file.  

Examples:  

Movie Maker has created a series of wizards to help you save your movie in a way to 
share it with other people. In figure 1.31 shows the content of finish movies. 

 
Figure-1.31: Content of Finish Movie 

Simply click on the type of movie you want to save your project as, and this will start the 
wizard. For this example we will use the Save to my computer wizard. Note: Depending on 
the length of your movie this process can take a long time. So make sure you have 
something to do for a while. 

Step 1: The first step is to give the movie a name, and tell the wizard where you would like 
to save the movie as represented in figure 1.32. Now go ahead and click Next. 
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Figure-1.32: Snapshot of Movie Wizard  

Step 2: The second step is to determine how the output of the movie will be shown in 
figure 1.33. The safest way to export your movie is to choose Best quality for playback on 
my computer (recommended). 

 
Figure-1.33: Second Step of Movie Wizard  



 28 

Now go ahead and click Next. This will start the creation of your movie.  

Step 3: The next window will show the progress of the movie being exported as 
represented in figure 1.34. 

 
Figure-1.34: Third Step of Movie Wizard 34  

Step 4: When Movie Maker is done exporting the film the finish screen will be seen like 
this as shown in figure 1.35. 

 
Figure-1.35: Snapshot of Fourth Step of Movie Wizard  

At the end open up the file, and watch the epic film. 
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Exercise: 
Q1.  Publish your movie to your computer by following the steps listed below: 

 Click file 

 Click publish movie. 

 Click this computer, and then click next. 

 In the file name box, type a name for your movie. 

 In the publish to box, choose where ever want to save the movie once it's 
published, and then click next. 

 Choose the settings to be used to publish the movie 

 Click on publish. 

Assessment: 
Answer the following questions: 

Q1.  Explain the various Steps to save and publish the video generated. 

Q2.  Explain the information which the Published movie should not contain. 

Q3.  Can you avoid adding the credits to your video? 

Q4.  Is there any difference between saving and publishing? 
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Chapter - 2: Customizing and Embedding 
Multimedia Components in Web Pages 

 

Learning Objectives 
After studying this unit the students will be able to: 

 Understand the definition of Multimedia and what it means to use it. Its format. 

 Discover the kinds of media used in multimedia and understand how to combine them. 
Learn about formats of Multimedia. 

 Describe the different methods of defining images, video and flash on Web pages. 

Introduction  

Multimedia is many things rolled into one. What do you think of when you hear the word 
Multimedia? Is it merely a mash up of media elements? Or is it everything we see, hear, read, 
and touch in websites, video games, phone, phone apps, retail kiosks, and bank ATMs? There 
are all forms of multimedia, and the list of uses grows daily. We are drawn into multimedia at 
every run, whether we like it or not. The goal of this content is to demystify the meaning and 
process of creating digital multimedia. 

Multimedia has become an inevitable part of any presentation. It has found a variety of 
applications right from entertainment to education. The evolution of internet has also increased 
the demand for multimedia content. 

Multimedia is the media that uses multiple forms of information content and information 
processing (e.g. text, audio, graphics, animation, video, interactivity) to inform or entertain the 
user. Multimedia also refers to the use of electronic media to store and experience multimedia 
content. Multimedia is similar to traditional mixed media in fine art, but with a broader scope. 
The term “rich media” is synonymous for interactive multimedia. 

Resource Requirement 
Hardware: A computer system  

Software: Simple web pages does not required any software. 

2.1  Customizing and Embedding Multimedia Components in Web Pages 

Introduction: Multimedia comes in many different formats. It can be almost anything you 
can hear or see. 

Examples: Pictures, music, sound, videos, records, films, animations, and more. 
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Modern Web pages have often embedded multimedia elements, and modern browsers 
have support for various multimedia formats. 

Multimedia elements (like sounds or videos) are stored in media files. 

The most common way to discover the type of a file, is to look at the file extension. When 
a browser sees the file extension .htm or .html, it will treat the file as an HTML file. The 
.xml extension indicates an XML file, and the .css extension indicates a style sheet file. 
Pictures are recognized by extensions like .gif, .png and .jpg. 

Multimedia files also have their own formats with different extensions like: .swf, .wav, 
.mp3, and .mp4. 

Advantages & Disadvantages of Using Multimedia on Web Pages: 

Since the introduction of the Mosaic Web browser in 1993, Web designers have added 
multimedia elements to Web pages. What started as the simple addition of a few images 
expanded to include different types of multimedia and immersive environments. However, 
usability experts like Dr. Jakob Nielsen of the Nielsen Norman Group have expressed 
concerns about the negative impact of multimedia on the Web. 

Advantages:  

 Greater Immersion: Adding multimedia elements to a Web page make it easier to 
draw in viewers. While video is the most popular multimedia addition, sites also add 
audio and interactive content to attract and hold the attention of the viewers. 

 Enhanced Page Rankings for SEO: While the value of multimedia remains 
controversial in the search engine optimization world, surveys conducted by Forrester 
Research indicate that video content, done correctly, is a major benefit to a site's 
overall SEO strategy. The company discovered in 2010 that websites with videos were 
53 times more likely than text-based websites to appear on the first page of search 
engine results. 

 Better Branding: While HTML 5 text-based sites are more elaborate than websites of 
the past, they are still limited in many ways. It is hard to represent a brand's image 
without including audio or video content to support it. As such, multimedia sites are 
frequently preferred by marketing departments because of their ability to completely 
present branding. 

Disadvantages: 

 Potential Damage to Search Engine Rankings: While video content can help a site 
with search engines, images that are not handled correctly can damage a sites 
ranking. Sites lacking links an automated "spider" program can follow end up being 
ignored by search engines. Creators of multimedia content who do not keyword-
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optimize the content negate any SEO work on the non multimedia portion of the site. 
As a result, the site appears lower in search results, which affects its overall traffic 
flow. 

 Loading Times: While the days of measuring page load times on a slow, dial-up 
modem are over, multimedia content still takes longer to load than static content. 
Presenting a user who visits a site with a screen that says "Please Wait. Loading" 
frequently results in a viewer clicking away to a different page. 

 Compatibility: Every browser can display at least some subset of HTML. Multimedia 
elements not as widely supported. The best example of this is the absence of Flash 
multimedia on Apple's mobile devices. As of the middle of 2012, the devices still did 
not support Flash, causing sites that depend upon Flash to display incorrectly on iPads 
and iPhones. This problem applies to other types of multimedia, as well. A site that 
uses the Windows Media format for its multimedia content will frequently not work 
correctly for users on computers that lack a plug-in for Windows Media. 

Assessment: 
Answer the following questions: 

Q1.  Define multimedia and its various types? 

Q2.  Advantages and Disadvantages of multimedia in web pages? 

Q3.  Why we need internet browser? Also explain web page? 

Q4.  List 5 internet browser which supports multimedia? 

Q5.  Full form of HTML is ____________ and XML is_____________? 

2.2  Compatible Multimedia File Formats for Web Pages 

Images 

A single still video image, whether created by a drawing or paint program or scanned from 
a book or grabbed with a video camera, can be stored in any of a wide variety of file 
formats. The data will be stored in a raster or a vector file format. A raster image is one 
composed of a field of pixels, each characterized by a color, and is usually created in paint 
programs, by scanning a picture or by grabbing an image. A vector format is created 
almost always by a drawing/CAD program and consists not of pixels, but objects such as 
curves, shades, and characters. 

Raster formats can be generally separated into two categories. Lossy formats lose 
resolution (sharpness) when converted to, while lossless formats preserve image 
information. For example, when converting from a GIF (lossless) to a JPEG (lossy), some 
information is lost. However, lossy formats tend to be much smaller than their lossless 
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counterparts, and for most photographic images, there will be almost no subjective 
difference. 

The following list of image file formats is not inclusive, but describes the formats that 
comprise the majority of files encountered on the Internet. All of the following formats are 
raster formats unless otherwise stated. 

1) .gif: GIF, which stands for Graphics Interchange Format, is a graphics file format 
originally popularized by CompuServe. GIF files are encoded, 256 color (8-bit) images 
which use a lossless compression technique and can be opened by almost all 
graphics programs including xv, Lview, and Photoshop. 

2) .jpg, .jpeg, .jfif: JPEG stands for Joint Photographic Experts Group. JPG (more 
accurately JFIF) files are true color (16.7 million colors, or 24-bit) images that are 
compressed using a lossy compression algorithm called JPEG. This means that files 
may degrade in quality when they are JPEG encoded. However, this degradation is 
not noticeable for most scanned photographs and images with smoothly colored 
areas. Do not use JPEG encoding on line art or cartoon images. JPEG files are 
significantly smaller than most other formats and can be opened and saved with many 
graphics programs on all platforms. 

3) .ps, .eps, .epsi: Postscript (PS), Encapsulated Postscript (EPS), and Encapsulated 
Postscript with preview image (EPSI) are all vector graphics file formats. They are 
mainly used to store printed or printable documents and are in widespread use. 

4) .pdf: PDF stands for Portable Document Format and is created by Adobe Acrobat. An 
Enhancement of the Postscript language, PDF files contain all the same text and 
page layout information but can include many WWW features such as images, links, 
and heading references. PDF files can be viewed using Adobe Acrobat software. 

5) .tif, .tiff: TIFF (Tagged Image File Format) files are uncompressed true color images. 
Most graphics programs allow you to store TIFFs with compression. These files can 
be opened by many graphics programs including xv, Lview, and Photoshop. 

6) .tga: TGA (Targa) files, like TIFFs, are uncompressed true color (24-bit) images. They 
can be opened by many graphics programs including xv, Lview, and Photoshop. 

7) .pict: A PICT file is a standard Macintosh image file format and can be either a raster 
image or a vector image, depending on the program that created it. Most Macintosh 
applications will open them. 

8) .bmp: BMP files are Windows Bitmap files. They are usually 8-bit color images (256 
colors) and can be viewed by many programs including Windows Paintbrush. BMP 
files can be used as backgrounds for the Windows desktop. 

9) .pcx: A PCX is a Zsoft paint file. PCXs are openable by Windows Paintbrush. 
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10) .pbm,.ppm,.pgm: Portable Bitmap, Portable Pixmap, and Portable Graymap are all 
file formats used by the PBMtools set of Unix graphics utilities. Most commonly used 
on Unix workstations, they are openable by Photoshop in addition to xv. 

11) .psd: PSD signifies an Adobe Photoshop graphic file. They are openable on Pentium 
and Macintosh systems by Adobe Photoshop. 

12) .cvs: A CVS is a vector graphic file format and is openable by Canvas. 

13) .cgm: A Computer Graphics Metafile, CGM, is also a vector format and can be 
opened by Canvas and ClarisDraw. 

14) .wpg: WPG are WordPerfect graphics files that can be opened with Lview. 

15) .wmf: WMF files are Windows MetaFiles that can be opened by Canvas. 

16) .xpm, .xbm: X PixMap or X bitmap files are usually small files used in the X Window 
System. 

Different file formats work with different programs, although almost all drawing/paint 
programs will read and write JPEG, GIF, and TIFF formats. GIF and JPEG formats are 
popular for FTP and the WWW because they are much smaller than other formats, so 
more of them can be stored. GIF and JPEG formats are not compressible, so it is 
generally a waste of effort to run a compression program on them. However, other file 
formats often compress by large amounts. PICT and TIFF formats work best with word 
processing and desktop publishing programs like Microsoft Word 6.0 and Adobe 
Pagemaker 6.0. 

Movies 

Movies, as they are labelled here, consist of a series of still images, sometimes with 
embedded audio information, united in such a way as to produce a single playable file. 
MPEG and QuickTime are the two most commonly encountered movie formats on the 
Internet. 

1) .avi: AVI is a file format developed by Microsoft and primarily used in Windows. AVIs 
are compressed movies that can be viewed in Windows environments with Media 
Player and on Unix workstations with xanim. 

2) .flc, .fli: An FLC is an Autodesk Flick movie and is a raw, uncompressed series of 
frames. They take up more space than other formats, but the image quality is higher. 
You can play them within Windows with Media Player. 

3) .mov, .MooV, .qt: Any of these file extensions means that the file is an Apple 
Quicktime movie. Applications that can view QuickTime video include: Simple Text, 
WordPerfect, and Microsoft Word. Flattened QuickTime video clips can be viewed on 
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Unix workstations with xanim and on IBM-compatible personal computers with Media 
Player. 

4) .mpg, .mpeg: MPEG files use the MPEG-1 video compression routine, a universal 
protocol for creating and displaying time coded data created by the Motion Picture 
Experts Group. MPEG video clips can be viewed with mpeg_play on Unix 
workstations, Sparkle on Macintoshes, and MPEG_PLAY on IBM-compatible 
personal computers. 

Sound 

Files containing data used to recreate audio on a computer are called audio files and are 
also available in many different formats. Similar to image formats, audio files can either 
store a digital sampling of the sound wave (sound files, like a raster image) or contain a 
digital encoding of the type, shape, and timing of all the notes used in the composition 
(music files, like vector images). 

1) .au: An AU is an audio sound file native to Sun workstations. It is playable by wplany 
on Pentium computers or with Netscape's built-in AU player. 

2) .iff : An IFF is a sound file playable on Pentium computers with wplany and on Unix 
workstations with xanim. 

3) .mid, .rmi: MIDI files can be played with the Windows MIDI sequencer. They are 
music files that conform to the MIDI standard. Play them with Media Player on the 
Pentium computers, or load them into MusicProse or Finale on a Macintosh. 

4) .mod: A MOD file is a music file format originally from the Commodore Amiga, but 
which is now popular on IBM-compatible computers. 

5) .qt: A QuickTime movie can contain just sound and no video. Any program that can 
play QuickTime can play QT sound files. 

6) .snd: An SND is a Macintosh clickable sound format. It is playable on any Macintosh 
and on Pentium computers with wplany. 

7) .voc: VOC (voice) files were originally popularized by Creative Labs. They are sound 
files similar to WAV. These files are openable on Pentium computers with wplany. 

8) .wav: WAV (wave) files are Microsoft's native audio sound format. WAV files can 
include 8-bit or 16-bit sound, in mono or stereo. They can be played on Pentium 
computers with Media Player and wplany. 

Music software packages such as MusicProse and Finale, can also be used to compose 
music, but they use their own proprietary music formats. 
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Multimedia on the Web 

Once you have the appropriate software, you have to configure your WWW browser to 
automatically play/display any downloaded multimedia file. This procedure varies by both 
platform and software, but is somewhat similar. 

Helper applications are programs which can stand on their own but are referred to from 
within a WWW browser to enhance its capability to play/display multimedia file formats. 
Normally, you must tell your browser which programs to use for which file format 
encountered. Since Netscape Navigator is the most popular WWW browser for most 
computer platforms, its method of setting and using helper applications is be described 
below. 

Netscape for Macintosh or IBM-compatible computers can be customized to automatically 
respond to almost any file format encountered. To do this: 

Pull down the Options menu and select Preferences. 

From the selection box at the top of the window that opens, choose Helper Applications. 

Now, find the row corresponding to the multimedia file format you wish to automate with a 
helper application, and select the radio button corresponding to the action you wish 
Netscape to take: save, launch helper application, or use Netscape's built-in viewer. 

If you want Netscape to open a helper application, you must click once on Browse and 
select an appropriate program. 

Assessment: 
Answer the following questions: 

Q1. How can you differentiate between music, image and sound data without open? 

Q2.  Why today’s web site containing more and more multimedia? 

Q3.  Write tags which are used in to add images in web page? 

2.3 Embedding Audio in Web Pages 

Introduction 

Embedding a sound on a page means to include the sound commands in the HTML 
document. It will be nice to hear a background music while working with html files. And 
now it is very simple to include an audio file into HTML page. There are different syntax for 
different browsers.  

For example, Internet Explorer support the BGSOUND and Netscape support an embed 
tag for embedding music. 
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We have observed many times that free music downloads are available at various sites 
which we can listen. Those websites will give us a trail to download and hear the music at 
glance. We can just use those files for embedding in our html pages. In such cases, the 
embed tag is used much for the simplicity. 

In Internet Explorer (IE) the audio can be included using <BGSOUND> tag. bgsound tag 
works only in IE and not in any other browsers. 

Example Code: <bgsoundsrc="he-knows.wav" LOOP="-1" >  

The audio can be included using <embed> tag for Netscape like browsers. 

Example Code: <EMBED SRC="he-knows.mp3" HIDDEN="true" AUTOSTART="true" 
LOOP="infinite" Height=145 width=160></EMBED>  

This will include back-ground music into our webpage. If we want to display the audio 
controls in the browser, we can set the hidden attribute to false. Here in the above 
example we have used Loop=-1 which will play the file again and again. If you want to play 
it only once just set the loop to false. 

Various Quick and Easy Ways to Embed MP3 Files into the Site 

Now, we are going to look at some easy ways to embed MP3 files into our website. All of 
these methods are free and take mere minutes to implement.  

Simple Player with Editable Parameters 

a) Using the Object Tag:  
Apart from the non standard Embed tag, we can also use the <object> tag for 
embedding various media into our web pages. But, it is not still effective for cross-
browser functions. 

You can specify some parameters related to the document with the param tag. 
Parameters can be height, width, background color, loop, and autoplay. IE 
sometimes needs a src parameter to understand the location 

Example Code: 

<object data="music.wav" type="audio/x-mplayer2" width="320" height="240"> 

<param name="src" value="music.wav"> 

<param name="autoplay" value="false"> 

<param name="autoStart" value="0"> 

<param name="bgcolor" value="#FFFFFF"> 

Hear the sound : <a href="music.wav">music</a> 

</object>  
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Type attribute specifies the application/media player type you are using. We can use 
the following types for our media player: 

1)  Windows Media Player : type="application/x-mplayer2". 

2)  Quicktime: type="video/quicktime". 

3)  RealPlayer: type="audio/x-pn-realaudio-plugin". 

Step by Step Implementation to Embed Sound in the Web Page.  

We would require HTML Editor to edit the web page and Sound file that is to be 
embedded in the system 

Below Steps should be Processed to Embed the Audio Files: 

1) Open the Web page in an HTML editor. HTML editor must have the ability to 
edit the source code to follow these steps. 

2) Start with an object element: 

 <object> 

3) We'll add 4 parameters to the object. The first is "src" that tells the browser 
where to find the sound file. In this example, the sound file is eureka.wav and 
is found in the same directory as the Web page: 

 <param name="src" value="eureka.wav" /> 

4) If you want the sound file to play immediately after it's loaded, make the auto 
start parameter "true" otherwise make it "false": 

 <param name="autostart" value="true" /> 

5) The parameter autoplay is similar to autostart, just used by other browsers, 
set it the same as the autostart parameter: 

 <param name="autoplay" value="true" /> 

6) Use the controller parameter to tell the browser if a controller should be 
displayed to give your readers more control over the sound: 

 <param name="controller" value="true" /> 

7) Inside the <object></object> element, add an embed element: 

 <embed /> 

8) Add the following four attributes that are the same as the parameters to the 
object: 

 <embed src="eureka.wav" controller="true" autoplay="true" autostart="True" /> 

9) Add the correct MIME type for your sound file into the type attribute: 
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 <embed src="eureka.wav" controller="true" autoplay="true" autostart="True" 
type="audio/wav" /> 

10) Add the pluginspage attribute so that people who don't have the correct 
plugin for your sound file can go download it. For WAV files, I recommend 
QuickTime: 

 <embed src="eureka.wav" controller="true" autoplay="true" autostart="True" 
type="audio/wav" pluginspage="http://www.apple.com/quicktime/download/" /> 

11) When you're done, your HTML should look like this: 

 <object> 
 <param name="autostart" value="true"> 
 <param name="src" value="eureka.wav"> 
 <param name="autoplay" value="true"> 
 <param name="controller" value="true"> 
 <embed src="eureka.wav" controller="true" autoplay="true" autostart="True" 
 type="audio/wav" /> 
 </object> 

There are Some Important Tips and Measure which should be taken Care of, to 
make this Procedure Work: 

1) Don't validate your Web page with the embed tag. It won't validate because that 
tag is not part of the specification. But only Safari supports the object tag for 
sound. 

2) Check out the embed tag for additional attributes. Many of them you can use as 
parameters on your object as well. 

3) I recommend always setting the controller="true" attribute. That way, if someone 
doesn't want to hear sound on your Web page, they can turn it off. 

4) For the most accessible (and valid) sound, just link to your sound file. 

<a href="eureka.wav">Eureka sound file</a> 

That gives your customers the choice to listen or not. 

b) Google Reader MP3 Player 

Google Reader has an inbuilt MP3 player that is pretty much the same as Gmail 
player but it also works on non-Google websites. Google has an advantage that it is 
a free resource. This player has volume controls, no Google branding and it auto-
detects the duration of the music file so our readers know how long the song will last.  

Here’s a live example followed by the HTML embed code: 

To use this MP3 player on our website or blog, write the following code and replace 
the MP3_FILE_URL with the link to your MP3 file. 

http://www.apple.com/quicktime/download/
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<embed type="application/x-shockwave-
flash"flashvars="audioUrl=MP3_FILE_URL" 
src="http://www.google.com/reader/ui/3523697345-audio-player.swf" width="400px" 
height="27px" quality="best"></embed> 

<audioUrl=http://LINK" width="400" height="27" allowscriptaccess="never" 
quality="best" bgcolor="#ffffff" wmode="window" 
flashvars="playerMode=embedded"> 

Example: 

<embed height="27px" width="400px" 
pluginspage="http://www.macromedia.com/go/getflashplayer"  
flashvars="playerMode=embedded" wmode="transparent" bgcolor="#ffffff" 
quality="best" allowscriptaccess="never" 
src=http://www.google.com/reader/ui/3523697345-audio-
player.swf?audioUrl=MP3_FILE_URL 

type="application/x-shockwave-flash" classname="audio-player-embed"/>  

c) Yahoo! MP3 Player (inactive) 

Yahoo! offers a code generator (Easy Listener) to help us to create a Flash based 
MP3 player that matches our website color theme and layout. Though this Easy 
Listener MP3 player requires you to pass the address of the web page that contain 
the MP3 file(s), we can directly pass the MP3 link and it will work just fine.  

It supports auto play and we can decide where the meta data associated with the 
MP3 file should be displayed. 

Example:  

<embed src="http://webjay.org/flash/dark_player" width="400" height="40" 
wmode="transparent" flashVars="playlist_url=MP3_FILE_URL&amp;skin_color_1=-
145,-89,-4,5&skin_color_2=-141,20,0,0" type="application/x-shockwave-flash" /> 

d) Yahoo Media Player 

The Yahoo Media Player takes a drastically different approach by presenting viewers 
with a very minimal piece of text and a play button instead of a full-fledged player. 
However, when we click the play button, a floating player pops up that stays on 
screen as we scroll. 

If we maintain an MP3 blog or run a podcast and regularly link to MP3 files, it makes 
little sense to embed a separate Flash player with every MP3 file. It is would 
therefore recommend using the Yahoo Media Player that auto-detects links to MP3 
files in our web pages and creates an embedded player for each link. 

http://www.google.com/reader/ui/3523697345-audio-player.swf
http://LINK
http://www.macromedia.com/go/getflashplayer
http://www.google.com/reader/ui/3523697345-audio-
http://webjay.org/flash/dark_player
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All we have to do is to insert the following link in our blog template and all MP3 
hyperlinks will be converted into inline MP3 players. This also has the shuffle feature 
and visitors can easily skip to any song in the playlist. 

For the Yahoo player, it works similar to Yahoo Media Player, we first insert 
following link in our blog template and all MP3 hyperlinks will be converted into inline 
MP3 player. 

<script type="text/javascript"  

src="http://mediaplayer.yahoo.com/js"></script> 

Also note that even before we click the play button, the Yahoo player is docked and 
ready to go at the bottom left of the window. Just click on the arrow to slide it out. 

e) Odeo MP3 Player (inactive) 

Odeo offers a pretty impressive MP3 player that works perfect in web pages as well 
as RSS readers but a small issue is that Odeo Player requires you to type the exact 
duration of the song in the embed code. You can skip this step but then the progress 
bar won’t reflect the true status when you play the song. And there are no volume 
controls. 

To use Odeo MP3 player in your website, add the following code replacing 
MP3_FILE_URL and DURATION with relevant values. 

<embed type="application/x-shockwave-flash" 
src="http://www.odeo.com/flash/audio_player_standard_gray.swf" width="400" 
height="52" allowScriptAccess="always" wmode="transparent" 
flashvars="audio_duration=DURATION&amp;external_url=MP3_FILE_URL" /> 

f) MixPod 

MixPod creates a free flash widget to embed into our site. There are pros and cons 
to using this service compared to those above. The cons are that we have to sign up 
(free) and the player displays a link to MixPod. The pros are that we get a plethora of 
great design options, embedded song information including artist and song name, 
the ability to adjust the color scheme to match that of our site, and access to popular 
songs and playlists. 

Setting up a MixPod is super easy and requires no knowledge of coding beyond 
where to paste the snippet of code they give us. All we do is paste in our MP3 link, 
insert the artist/track info for all the songs in your playlist, and choose your skin and 
colors. Then MixPod provides you with a rather large chuck of code to paste into the 
site. The result is pretty slick. 

MixPod is just one of many providers of free flash players you can embed into your 
site.  

http://mediaplayer.yahoo.com/js
http://www.odeo.com/flash/audio_player_standard_gray.swf
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g) Helper Applications - A New search 

When the World Wide Web first got started, back when Mosaic was the browser and 
this new thing called Netscape 1.0 came out, sounds were available, but they were 
played with the use of a helper application. 

Helper applications were programs that attached to the Netscape browser. In order 
to play a sound file, like .wav, .au, or .aiff, you will need to attach an application that 
the browser can use to play the sound. 

We can use a program called WHAM. It's great and it plays a great many types of 
sound files. 

What Happens is this: 

 The browser gets the sound file and downloads the entire thing. 

 Once the download is complete, the helper application is launched. 

 The browser loads the sound file into the application. 

 The application plays the sound. 

Offering a Sound Via Helper Application 

If we have a sound, would like to offer, follow this format: 

<A HREF="http://www.yoursite.com/filename.wav"> Click Here</A> 

Notice it's nothing more than a simple link pointing to the sound file. Place the sound 
file in the same directory as the page that calls for it and the browser will take it from 
there. Just need to be take care of  and must be sure to FTP transfer the sound file 
to our site  as "binary" or "raw data," as any other way can corrupt it. 

By making the hypertext link to a sound file we are taking the chance that the person 
viewing the page on our site has an appropriate helper application. 

h) Using a Plug-in 

Plug-ins are programs that helps browser to perform at a higher level. A sound plug-
in does basically the same thing the helper application does, except it works inside 
the Netscape Navigator window rather than starting up as a whole other program. 
Instead of WHAM popping up and Netscape being pushed to the back while the 
sound runs, a sound plug-in works inside of Netscape Navigator allowing user to 
continue playing with the page while the sound is running. 

i) MIDI 

It's an acronym that stands for Musical Instrument Digital Interface. That's a program 
that acts as a go-between for an instrument and something that creates the sound. 
Sort of like running a guitar through a computer and then out a speaker. 

http://www.yoursite.com/filename.wav
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A midi file over the Web works as a program that runs the sound card. The midi file is 
not simply read and reproduced like a .wav or an .au file. The midi file sort of "plays" 
the sound card. It tells the sound card what note to produce and for what duration. 
Put enough of these notes together and it sounds like music. Most of the midi music 
that we hear sounds like a bad little Casio keyboard. Probably because that's the 
level at which our sound card can reproduce the sounds. Higher level sound cards 
can reproduce the MIDI just as clear as any instrument could. It's really amazing 
when you hear it. 

Format for an Embed: 

<EMBED SRC="peanuts.mid" AUTOSTART=FALSE LOOP=FALSE WIDTH=145 
HEIGHT=55 ALIGN="CENTER"> 
</EMBED> 

Important Points: 

 Embed tells the browser an embed sound is here -- go get the plug-in. 
Remember, embed commands are associated with plug-ins. 

 Note: If no plug-in is available, the browser will do one of three things: 

1) Do nothing. This is true of very early level browsers or browsers other than 
Netscape. 

2) Put up a dialogue box asking you how you want to handle the file. 
3) Tell you a plug-in is needed and ask you if you'd like to go get it. 

 Height/Width deals with the plug-ins control panel size on the page. The control 
panel at the top of the page was giving a size of 145 pixels wide by 55 pixels 
high. 

If we do not want a panel, add the command HIDDEN="yes" or set the height 
and width to zero. 

 Src stands for "source." It tells the browser where to go to get the audio file. 

 Autostart deals with whether we want the sound to play by itself or by the viewer 
starting the file after the plug-in box pops up. Its value can be either TRUE or 
FALSE. 
True starts the file straight away. It will play the sound when the page loads. 
False prompts the viewer. It will wait for the user to click on the play button. 

Note: we used "false" above. "True" would have started the file straightaway 
upon load. 

 Loop works the same way. The default value is FALSE which plays the file only 
once. Setting this to TRUE will play the sound continuously. "True" loops the 
sound so it plays forever. Make the loop "false" if you only want it played once. 
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2.4  Embedding Video in Web Pages 

Different Ways to Embed Video into a Web Page 

Since digital camcorders and video editing software became accessible to the large 
audience, it's no longer a challenge for anybody to make a video. This fact underlies a lot 
of web trends, namely the sky-rocketing popularity of video sharing portals and 
widespread use of video content across websites and blogs. A good piece of video can 
help us to deliver our message more effectively, educate readers, stimulate discussion 
and get our brand going far beyond our own domain. Happily, it's not a problem nowadays 
to integrate a video into a web page, as there's a lot of different tools to assist with this 
task. Some of them are free, others are pricey. Here is a roundup of the most popular 
means of web video embedment. 

 Youtube Embed Code 
If anyone run a branded channel on YouTube, there’s a good opportunity to use 
YouTube embedding facilities.  

There are some obvious marketing benefits of this method:  

Once submitted, our video gets involved into the full cycle of YouTube life with its 
views, search queries, comments, ratings, playlists, etc. Thus, it increases the 
chances of our video content attracting visitors to our resource.  

The embedment procedure is fast and easy: 

We upload a video to our channel, go to the player, acquire the embed code and 
paste it into our web page. YouTube also provides additional options to customize the 
player like play in HD, switch to HTTPS, suggest other videos, etc. 

 
Figure-2.1 
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 Vimeo Embed Code 

Vimeo is YouTube's main rival, especially in the area of video embedment options. 
Vimeo videos are also viewed by thousands of web users and can be easily 
integrated into other websites or blogs. Vimeo player is very handsome and 
streamlined. The blue “Embed” button in the upper right of the video leads to a dialog 
box with the embedding options. Basic account holders are allowed to customize 
player size, text colors and add other elements, while Vimeo Plus members enjoy the 
complete control over the player, including options to choose what happens next and 
where the video can appear. 

 
Figure-2.2 

 Facebook Video Integration 

Facebook doesn't officially provide any video embedding options, still if a video is 
available only on Facebook, there is a workaround. Each video on Facebook has an 
id which shows in the URL, e.g. 

http://www.facebook.com/video/video.php?v=2894326448598. Copy the last digits 
and paste them into the following code instead of xxx in the video link: 

<objectwidth="400"height="224"> 

<paramname="allowfullscreen"value="true"/> 

http://www.facebook.com/video/video.php?v=2894326448598.
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<paramname="allowscriptaccess"value="always"/> 

<paramname="movie"value="http://www.facebook.com/v/xxx"/> 

<embedsrc="http://www.facebook.com/v/xxx"type="application/x-shockwave-flash" 

allowscriptaccess="always"allowfullscreen="true"width="400"height="224"> 

</embed> 

</object> 

Then we can put that code on any web pages and the Facebook video will play just 
like any other Flash video. We can optionally change the player size, add more 
parameters like autoplay or loop. 

 Html5 Video 

HTML5 is one of the most straightforward new techniques of video embedment. The 
new <video> tag in HTML5 markup allows web developers to add videos into a web 
page without any special plugins. To make the most of HTML5 video, we have to 
prepare the video in three variants – H.264, Theora OGG and WebM, since different 
web browser support this or that video codec for the new HTML5 standard. The 
sample code for HTML5 video looks like this: 

<videowidth="320"height="240"controls autoplay poster="video.jpg"> 

<sourcesrc="movie.mp4"type="video/mp4"/> 

<sourcesrc="movie.ogg"type="video/ogg"/> 

Your browser does not support the video tag. 

</video> 

This method has one obvious disadvantage – HTML5 video isn't supported by old 
versions of Internet Explorer (5, 6, 7, 8) which are still used by the majority of web 
users. So the old-style Flash embedding code inside the HTML5 video element is 
often provided as fallback. 

 Freemake Video Converter 

If we don't want to outsource video hosting to third-party websites, it's possible to 
make a video web-ready with the help of Free Video Converter from Freemake.com. 
This video converter outputs to Flash FLV and SWF formats. The main advantage of 
this tool is that it provides ready HTML code and step-by-step instructions on how to 
embed it. Alternatively, we can convert the videos to HTML5 supported format, the 
converter will prepare all three video variants in a batch and show how to integrate 
them into HTML5 markup. The software is for Windows only. 

http://www.facebook.com/v/xxx
http://www.facebook.com/v/xxx
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Figure-2.3 

 Oembed 

OEmbed is an open standard for embedding videos and images into a website. We 
can use the video URL available on YouTube, Vimeo, Dailymotion, Flickr, Scribd, 
Hulu and supported resources. The simple API allows websites to display embedded 
content when a user posts a link to that resource, without having to parse the 
resource directly. So we don't have to copy and paste HTML code from a hosting 
website every time we wish to embed a video. The best example of OEmbed 
integration is Facebook’s status update: when we paste a YouTube link in the status 
bar, it is automatically rendered in the video player. OEmbed easily integrates into 
WordPress via Shortcode API, the instructions are provided. 

 Quick Media Converter 

Quick Media Converter is another Windows-based converter for audio and video. It 
outputs to Flash, QuickTime, RealMedia, H.264, OGG, so it is possible to make a 
streaming video for HTML or HTML5 web integration. Video parameters are easily 
customizable. However, no embed code or batch mode conversions are provided. 
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Figure-2.4 

 Free Video Coding 

Free Video Coding is an online service which helps us to create a web video player. 
Once we enter the website, we get into the FreeVideoCoding wizard. We just need to 
answer simple questions and the app will create custom HTML video codes based 
on the answers. Then we can choose WMV, MOV, SWF, FLV, RM, MPEG, and even 
AVI for the output.  

 
Figure-2.5 
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 Video Lightbox 

Video LightBox is a wizard program for Windows and Mac that helps users easily 
insert video to the website or blog, in a few clicks without writing a single line of code. 
It is free for non-commercial use, business licenses need to purchase it. To embed a 
video, we need to add a video URL (from YouTube, Facebook, Google Video, 
Metacafe, Vimeo, MySpace) or drag and drop a desktop video file, then select the 
template and publish the result to our website via a built-in FTP client. 

Video LightBox offers a wide range of video player templates: rounded, rectangular, 
in Polaroid, Mac, Facebook or even a yellow sticker style. 

 
Figure-2.6 

 Easy HTML 5 Video 

Easy HTML5 Video, as the name hints, is developed to convert videos into HTML5 
supported WebM, MP4, and OGG formats. It provides all formats in a batch, embed 
code and Flash fallback. Plus, it features additional options such as the ability to 
publish video from the software interface, specify controls for the HTML5 video 
player, select the video thumbnail, resize video and add a watermark. The program 
works for Windows and Mac OS, to use it for business purpose, it is required to buy 
a license for the same. 
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Figure-2.7 

The methods listed above are well suited for both novice and savvy web developers, each 
of them having their own pros and cons. Thus, if you opt for a third-party video hosting, 
keep in mind that the existence of the videos will be fully dependent on the video channel 
policy. Self-hosted videos can hardly be deleted or republished outside our own resource, 
but we won't reap the marketing benefits of additional video broadcasting. So it's up to us 
to decide which method of video embedding to pursue. Still don't forget that posting videos 
on a regular basis will surely diversify our web content and maximize our online business 
presence. 

 

2.5  Embedding Flash Files in Web Pages 

There are many ways to insert your Flash project into a web page. This page will cover 
several different methods, including using the Adobe Dreamweaver program, or doing it 
manually by writing out the code. 

Different ways to Embed Flash file into a Web Page 

 Inserting Flash into a Dreamweaver Page 

Inserting Flash into Dreamweaver is a pretty straightforward process. Within 
Dreamweaver, pull down the Insert menu and select Media, then select Flash 
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Figure-2.8 

Dreamweaver will present us with an accessibility box. Use the title field to describe 
the project. 

 
Figure-2.9 

 Inserting Flash into Web Pages Manually with Code 

There are times, particularly when using a content management system, where we 
will have to insert some Flash media into a web page by typing out the code 
manually. To insert Flash onto a web page or content management system 
manually, we must first upload the SWF file to a web server using a protocol called 
FTP or through an upload form on the content management system. 

Once we have the URL to our SWF file on the web, we can use the code samples 
below, simply swapping out somefilename.swf for our own URL, and change the 
width and height to the dimensions of our own Flash project. The code below can 
appear complex, but works for all Flash content. Here is the gist of the code: 

<object width="550" height="400"> 

<param name="movie" value="somefilename.swf"> 

<embed src="somefilename.swf" width="550" height="400"> 

</embed> 

</object> 
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This above block of code uses two primary tags: 

1.  The <object> tag, and  

2.  The <embed> tag.  

The <object> tag is the web standard for embedding content on to a web page, but 
the <embed> is a carryover from the days of the Netscape browser, and is not 
actually a valid tag in web standards. However, it is still widely used today to embed 
Flash content due to its wide compatibility with multiple browsers. Many popular sites 
like YouTube still offer embed code follows the above format. 

 Embedding Flash Media so it Validates 

A much better alternative, that is standards compliant, is to include what are 
called comment tags that are used by Internet Explorer browsers. This method is a 
pseudo hack, but conforms to the W3 standard and helps to achieve a 
standardization across the World Wide Web. 

<!--[if !IE]> --> 
<object type="application/x-shockwave-flash" data="somefilename.swf"  
width="300" height="200"> 
<!-- <![endif]--> 
<!--[if IE]> 
<object classid="clsid:D27CDB6E-AE6D-11cf-96B8-444553540000"  
codebase="http://download.macromedia.com/pub/shockwave/cabs/flash/swflash.cab
#version=6,0,0,0"  
width="300" height="200"> 
<param name="movie" value="somefilename.swf" /> 
<!--> 
</object> 
<!-- <![endif]--> 

Note that in each of these examples, there are two locations we must swap out with 
the URL to our flash file. Also, we should remember to set the correct width and 
height (there are two locations in each of the examples above). We can also create 
our own web standards embed code using the Validifier Online Tool. 

A third method for embedding Flash content is to use some JavaScript programming 
code to embed Flash content. This is generally seen as the best method, as it 
circumvents lots of issues and bugs with embedding Flash across multiple browsers; 
such as the notorious click-to-activate security features in some Internet Explorer 
browsers that forces the user to click on the Flash content to activate it before they 
can interact with it. Often, this method is not possible to do within a content 

http://download.macromedia.com/pub/shockwave/cabs/flash/swflash.cab
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management system by a user, unless the feature is built into the CMS. The code to 
do this is beyond the scope of this tutorial, but the more popular tools to do this is 
called SwfObject. 

Steps for Embedding Flash Files (SWF files) is Shown below: 

Step 1: Upload the SWF file(s) to an external Web host.  

We need find a Web host (e.g. FTP server) and upload our SWF on it. Generally, an 
account and password are required.  

Step 2: Once we have successfully uploaded the SWF files to an external Website, 
add the following code to any of the sections in the Web page, Blog, MySpace or 
even a post: 

&lt;script language="javascript"> 
document.write('&lt;objectclassid="clsid:D27CDB6E-AE6D-11cf-96B8-
444553540000"  
codebase="http://download.macromedia.com/pub/shockwave/cabs/flash/swflash.cab
#version=9.0.0.0" width=" 720" height="540" ID="swf" VIEWASTEXT>');  
document.write(' &lt;param name="movie" 
value=http://www.wondershare.com/pro/flash-gallery-factory-deluxe.html />');  
document.write(' &lt;param name="quality" value="high" />');  
document.write(' &lt;param name="wmode" value="window" />');  
document.write(' &lt;param name="allowScriptAccess" value="always" />');  
document.write(' &lt;param name="allowFullScreen" value="True" />');  
document.write(' &lt;embedsrc=http://www.flash-slide-show.com/demo.swf 
quality="high" name="sf" allowScriptAccess="always" allowFullScreen="true"  
pluginspage="http://www.macromedia.com/go/getflashplayer" type="application/x-
shockwave-flash"  
width="720" height="540">&lt;/embed>');  
document.write('&lt;/object>');  
&lt;/script>  

Step 3: Replace the SWF file link http://www.wondershare.com/pro/flash-gallery-
factory-deluxe.html with your own path and file name. Save the changes.  

Assessment: 
Answer the following questions: 

Q1.  Write tags used in to add audio file in web page? 

Q2.  Write tags used in to add video file in web page? 

Q3.  Write tags used in to add flash file in web page? 

Q4.  What is CSS and what are the current version available of it? 

http://download.macromedia.com/pub/shockwave/cabs/flash/swflash.cab
http://www.wondershare.com/pro/flash-gallery-factory-deluxe.html
http://www.flash-slide-show.com/demo.swf
http://www.macromedia.com/go/getflashplayer
http://www.wondershare.com/pro/flash-gallery-
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Chapter - 3: Web Scripting - Java Script 
 

Introduction 

JavaScript is an interpreted computer programming language. It was originally implemented as 
part of web browsers so that client-side scripts could interact with the user, control the browser, 
communicate asynchronously, and alter the document contents. Nowadays, JavaScript has 
become very useful in both game development and the creation of desktop applications. 

JavaScript was developed in 1995 by Brendan Eich, at Netscape, and first released with 
Netscape 2 early in 1996. It was initially called as LiveScript, but was renamed as JavaScript in 
order to capitalize the popularity of Sun Microsystem's Java language. JavaScript's use in 
applications outside of web pages also like in PDF documents, site-specific browsers, and 
desktop widgets and other useful applications. 

JavaScript was formalized in the ECMAScript language standard and is primarily used as part of 
a web browser (client-side JavaScript). This enables programmatic access to computational 
objects within a host environment. JavaScript very quickly gained widespread success as a 
client-side scripting language for web pages. Microsoft introduced JavaScript support in its own 
web browser, Internet Explorer, in version 3.0, released in August 1996. 

3.1 Java Script Review  

JavaScript is a cross-platform, object-oriented scripting language. JavaScript is a small, 
lightweight language. It is not useful as a standalone language, but is designed for easy 
embedding in other products and applications, such as web browsers. Inside a host 
environment, JavaScript can be connected to the objects of its environment to provide 
programmatic control over them. 

Core JavaScript contains a core set of objects such as Array, Date, Math, and a core set 
of language elements such as operators, control structures, and statements. Core 
JavaScript can be extended for a variety of purposes by supplementing it with additional 
objects.  

  Client-side JavaScript extends the core language by supplying objects to control a 
browser (Navigator or another web browser) and its Document Object Model (DOM). 
For example, client-side extensions allow an application to place elements on an 
HTML form and respond to user events such as mouse clicks, form input, and page 
navigation. 

  Server-side JavaScript extends the core language by supplying objects relevant to 
running JavaScript on a server. For example, server-side extensions allow an 
application to communicate with a relational database, provide continuity of 
information from one invocation to another of the application, or perform file 
manipulations on a server. 
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Standardization 

In November 1996, Netscape announced that it had submitted JavaScript to European 
Computer Manufacturers Association (ECMA) for consideration as an industry standard, 
and subsequent work resulted in the standardized version named ECMAScript. ECMA is 
an international standard organization for information and communication system. In June 
1997, ECMA International published the first edition of the ECMA-262 specification. A year 
later, in June 1998, some modifications were made to adapt it to the ISO/IEC-16262 
standard, and the second edition was released. The third edition of ECMA-262 is the 
version most browsers currently use.  

Fourth edition of ECMAScript standard was not released and does not exist. Fifth edition 
of the ECMAScript standard was released in December 2009. The current edition of 
ECMAScript standard is 5.1 and it was released in June 2011. This way, JavaScript has 
become one of the most popular programming languages on the web.  

Applications  

Developing Multimedia Applications   

The users can use JavaScript to add multimedia elements. With JavaScript you can show, 
hide, change, resize images and create images rollovers. You can create scrolling text 
across the status bar, thus making multimedia applications more interactive. 

Create Pages Dynamically 

Based on the user’s choice, the date or other external data, JavaScript can produce pages 
that are customized to the user. 

Interact with the User 

JavaScript can do some processing of forms and can validate user input when the user 
submits the form. 

JavaScript Objects are Similar to Dictionaries 

In JavaScript, objects are just collections of name-value pairs. JavaScript objects are 
considered as a dictionary with string keys. The users can get and set the properties of an 
object using either the familiar "." (dot) operator, or the "[ ]" operator, which is typically 
used when dealing with a dictionary.  

Features of JavaScript 

Browser Support 

All browsers have accepted JavaScript as a scripting language and provide integrated 
support for it. For example, to access flash content, you need to install flash plug-in in your 
browser. But to use JavaScript, you don't have to use any plug-in at all.  
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JavaScript can be used on Client Side as well as on Server Side 

JavaScript has access to Document Object Model DOM of browser. You can change the 
structure of web pages at runtime. Thus, JavaScript can be used to add different effects to 
WebPages. On the other hand, JavaScript could be used on the server side as well.  

Functional Programming Language 

In JavaScript, function could be assigned to variables just like any other data types. A 
function can accept another function as a parameter and can also return a function. You 
can have functions with no name as well. This provides you the ability to code in functional 
programming style.  

Support for Objects 

JavaScript is an object oriented language. However, the way JavaScript handles objects 
and inheritance is bit different from conventional object oriented programming languages 
like C++/ Java. JavaScript supports most of the object oriented concepts while being 
simple to learn and use.  

Run-time Environment 

JavaScript typically relies on a run-time environment (e.g. in a web browser) to provide 
objects and methods by which scripts can interact with "the outside world". In fact, it relies 
on the environment to provide the ability to include/import scripts (e.g. HTML <script> 
elements). This is not a language feature as such but it is common in most JavaScript 
implementations. 

Vendor-specific Extensions 

JavaScript is officially managed by Mozilla Foundation, and new language features are 
added periodically. However, only some JavaScript engines support these new features.  

Object based Features Supported by JavaScript 

JavaScript supports various features related to object based language and JavaScript is 
sometimes referred to as an object-based programming language. Some robust features 
which JavaScript supports related to object based are as follows:  

Object Type 

JavaScript supports the development of object types and in this context JavaScript 
supports both predefined and user-defined objects. It is possible to assign objects of any 
type to any variable. It is possible to instantiate the defined object types to create object 
instances in JavaScript, which is a very powerful feature of Object based language.  

Object Instantiation  

In order to carry out the process of creating specific object instances available in 
JavaScript, you can make use of a new operator. These two powerful, object-based 
features supported by JavaScript described above make this an object model language. In 
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JavaScript, the object types are defined by properties and methods. Properties of Objects 
are used to access the data values contained in an object. You can make use of the 
properties of JavaScript objects for editing as well as reading depending on the object’s 
nature. That is, if you want to carry out functions on the object, this is achieved by using 
methods that make use of the object’s properties.  

These are some of the features that give JavaScript an ability to handle simple as well as 
complex tasks. This way, JavaScript has remained as the most popular programming 
language for a long time. It is also a good language for web designers who want to learn 
computer programming as it supports object oriented as well as function concepts and to 
use it, you just need a browser and a text editor.  

Writing Java Script 

JavaScript code is typically embedded in the HTML, to be interpreted and run by the 
client's browser. Here are some tips to remember when writing JavaScript commands. 

  JavaScript code is case sensitive 

  White space between words and tabs are ignored 

  Line breaks are ignored except within a statement 

  JavaScript statements end with a semi- colon; 

The Script Tag 

The <SCRIPT> tag alerts a browser that JavaScript code follows. It is typically embedded 
in the HTML. 

<SCRIPT language = "JavaScript"> 

statements 

</SCRIPT> 

Examples 

Variables in JavaScript can be defined using the var keyword:  

var x;  

//defines the variable x, although no value is assigned to it by default 

var y = 2; 

 //defines the variable y and assigns the value of 2 to it 

Note the comments in the example above, both of which were preceded with two forward 
slashes. 

There is no built-in I/O functionality in JavaScript as such. It is the runtime environment 
which provides I/O functionality. The ECMAScript specification in edition 5.1 mentions. 
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Actually, there are no provisions in this specification for input of external data or output of 
computed results. However, most runtime environments have a console object that can be 
used to print output. Here we elaborate with the help of a Hello World program: 

console.log("Hello world!"); 

Relationship Between JavaScript Versions and ECMAScript Editions 

The following table describes the relationship between JavaScript versions and 
ECMAScript editions. 

Table : JavaScript versions and ECMAScript editions 

JavaScript 
version 

                Relationship to ECMA Script edition 

JavaScript 1.1 ECMA-262, Edition 1 is based on JavaScript 1.1. 

JavaScript 1.2 ECMA-262 was not complete when JavaScript 1.2 was released. 
JavaScript 1.2 is not fully compatible with ECMA-262, Edition 1, for the 
following reasons:  

 Netscape developed additional features in JavaScript 1.2 that were 
not considered for ECMA-262. 

 ECMA-262 adds two new features: internationalization using 
Unicode, and uniform behavior across all platforms. Several 
features of JavaScript 1.2, such as the Date object, were platform-
dependent and used platform-specific behavior. 

JavaScript 1.3  JavaScript 1.3 is fully compatible with ECMA-262, Edition 1. 
JavaScript 1.3 resolved the inconsistencies that JavaScript 1.2 had with 
ECMA-262, while keeping all the additional features of JavaScript 1.2 
except == and !=, which were changed to conform with ECMA-262.  

JavaScript 1.4  JavaScript 1.4 is fully compatible with ECMA-262, Edition 1. 
The third version of the ECMAScript specification was not finalized 
when JavaScript 1.4 was released.  

JavaScript 1.5 JavaScript 1.5 is fully compatible with ECMA-262, Edition 3. 
 

Why JavaScript? 

JavaScript is a simple scripting language invented specifically for use in web browsers to 
make websites more dynamic. On its own, HTML is capable of outputting more-or-less 
static pages. Once you load them up your view doesn't change much until you click a link 
to go to a new page. Adding JavaScript to your code allows you to change how the 
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document looks completely, from changing text, to changing colours, to changing the 
options available in a drop-down list and much more. 

JavaScript is a client-side language, which means all the action occurs on the client's 
(reader's) side of things. This means that no trips to the server are required for JavaScript 
to kick into operation, which would slow down the process enormously. JavaScript 
operations are usually performed instantaneously. In fact, JavaScript is often used to 
perform operations that would otherwise encumber the server, like form input validation. 
This distribution of work to the relatively quick client-side service speeds up the process 
significantly. 

JavaScript is integrated into the browsing environment, which means they can get 
information about the browser and HTML page, and modify this information, thus changing 
how things are presented on your screen. This access to information gives JavaScript 
great power to modify the browsing experience. They can also react to events, such as 
when the user clicks their mouse, or points to a certain page element. This is also a very 
powerful ability. 

Browser Compatibility  

JavaScript is supported by Netscape 2+, Internet Explorer 3+, Opera 3+ and most of the 
other modern web browsers. Each new version of the main browsers has supported new 
generations of JavaScript commands, each more complex than the earlier one. However, 
script compatibility can still be a problem, as the language is not as standardised as 
HTML. 

Writing First JavaScript 

How are the users going to get JavaScript into web pages? JavaScript is written in the 
same way as HTML in a text-editor. JavaScript implementation is quite similar to CSS 
(Cascading Style Sheets). The users can link to outside files (with the file extension .js), or 
write blocks of code right into your HTML documents with the <script> tag.  

Let us consider a simple example with an embedded script. This will simply print a line of 
text to the web page. 

<script type="text/javascript"> 

<!-- 

document.write("<i>Hello World!</i>"); 

//comment line ………this is comment  

</script> 

When you place that in your code the text Hello World will appear on your screen 
wherever you put it. Like so: 

Hello World!  
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The script tag encloses any script code you want to use. The type attribute we have to 
alert the browser to the type of script it is about to deal with, and so helps it to interpret the 
code. 

The comments around the script code are there so that old browsers that don't understand 
the script tag won't display the code as text on the page. Any browser that can do 
JavaScript will disregard the comments. Also note that for Netscape's benefit, the end of 
the comment is itself commented out using a JavaScript comment (two forward-slashes 
to comment out the rest of the line). This stops errors from occurring in old versions of 
Netscape. 

External Scripts 

To import scripts from external JavaScript files, save the code in a text file with the .js 
extension without the script tags and comments. In this case the code would just be the 
document.write("Hello World!"). The users can link to this document in the page's <head> 
with the following code. 
<script type="text/ javascript" 
src="simplemethods.js"></script> 

Now all the methods and variables that are in that file are available to use in the page. The 
users should always place includes in the head so that the browser is ready to execute 
scripts when the user calls for them. If a user clicked a button that called for a script that 
browser wasn't aware of yet, you may get an error. Having them in the head body means 
they're always ready before they're needed. 

A Simple Script 
<script type="text/javascript"> 
<!-- 
document.write("<i>Hello World!</i>"); 
//--> 
</script> 

Document object uses its write( ) method to output some text to the page-document. The 
text inside the double quotes is called a string, and this string will be added to the page. 
To use an object's methods or properties we write the object's name, a dot [. ] and then 
the method/property name. Each line of script ends with a semicolon. JavaScript isn't very 
forgiving that is if you make any mistakes in typing, the users will get a script error.  

Example for creating some HTML and text. 
<script type="text/javascript"> 
<!-- 
document.write("<h1>Main Title</h1>"); 
document.write("<p align='right'>Body</p>"); 
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//--> 
</script> 

Note that when quoting attribute values, you have to use single quotes, as if you used 
double quotes the write method would think the string was over prematurely, and you'd get 
an error. 

How to Save and Run your Program in JavaScript 
1. Open any editor like notepad and write the program 

2. Save the program in a file with .html extension in a proper folder or subfolder on a 
drive. 

3. Open the web browser like internet explorer or Mozilla Firefox  

4. Open the file you created and save in step 2, to execute the program like to execute 
C:/JAVA/firstprogram.html 

Where C is the drive, JAVA is the folder name and firstprogram.html is the name of 
program which is saved in the Java folder 

Programming using JavaScript   

JavaScript language has no concept of input or output. It is designed to run as a scripting 
language in a host environment. It is up to the host environment to provide mechanisms 
for communicating with the outside world. The most commonly used host environment is 
the browser. Although, JavaScript interpreters can also be found in other formats such as 
Adobe Acrobat, Photoshop, Yahoo!'s Widget engine, and server side environments. 
JavaScript programs manipulate values, and these values all belong to a type. Different 
JavaScript's types include Number, String, Boolean and Objects. 

Objects provide a great deal of utility in writing more maintainable code. If a function relies 
on one or two other functions that are not useful to any other part of your code, you can 
nest those utility functions inside the function that will be called from elsewhere. This 
keeps the number of functions that are in the global scope down. 

Note: When writing complex code it is often tempting to use global variables to share 
values between multiple functions, which leads to code that is hard to maintain. Nested 
functions can share variables in their parent, so you can use this mechanism to couple 
functions together when it makes sense without disturbing your global namespace 
'local/global' if you desire so. This approach should be applied with caution, but it's a 
useful ability to have for potential users. 

Operators 
JavaScript operators can be used to perform various operations such as: 
  Arithmetic Operators 
  Comparison Operators 

  Logical Operators 
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  Relational Operators 

  Assignment Operators 

  Conditional Operators 

The Arithmetic Operators:  

There are following arithmetic operators supported by JavaScript language: Assume 
variable A holds 10 and variable B holds 20 then: 

Operator Description Example 

+ Adds two operands A + B will give 30 

- Subtracts second operand from the first A - B will give -10 

* Multiply both operands A * B will give 200 

/ Divide numerator by denominator B / A will give 2 

% Modulus Operator and remainder of after an integer 
division 

B % A will give 0 

++ Increment operator, increases integer value by one A++ will give 11 

-- Decrement operator, decreases integer value by one A-- will give 9 
 

The Comparison Operators: There are following comparison operators supported by 
JavaScript language. Assume variable A holds 10 and variable B holds 20 then 

Operator Description Example 

== Checks if the values of two operands are equal or not, 
if yes then condition becomes true. 

(A == B) is not 
true.  

!= Checks if the values of two operands are equal or not, 
if values are not equal then condition becomes true. 

(A != B) is true.  

> Checks if the value of left operand is greater than the 
value of right operand, if yes then condition becomes true. 

(A > B) is not 
true.  

< Checks if the value of left operand is less than the 
value of right operand, if yes then condition becomes 
true. 

(A < B) is true.  

>= Checks if the value of left operand is greater than or 
equal to the value of right operand, if yes then 
condition becomes true. 

(A >= B) is not 
true.  

<= Checks if the value of left operand is less than or equal 
to the value of right operand, if yes then condition 
becomes true. 

(A <= B) is true.  
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The Logical Operators: There are following logical operators supported by JavaScript 
language. Assume variable A holds 10 and variable B holds 20 then: 

Operator Description Example 

&& Called Logical AND operator. If both the operands are 
non-zero then condition becomes true. 

(A && B) is true.  

|| Called Logical OR Operator. If any of the two operands 
are non-zero then condition becomes true. 

(A || B) is true. 

! Called Logical NOT Operator. Use to reverses the 
logical state of its operand. If a condition is true then 
Logical NOT operator will make false. 

! (A && B) is 
false.  

 

The Bitwise Operators: There are following bitwise operators supported by JavaScript 
language. Assume variable A holds 2 and variable B holds 3 then: 

Operator Description Example 

& Called Bitwise AND operator. It performs a Boolean 
AND operation on each bit of its integer arguments. 

(A & B) is 2. 

| Called Bitwise OR Operator. It performs a Boolean OR 
operation on each bit of its integer arguments. 

(A | B) is 3. 

^ Called Bitwise XOR Operator. It performs a Boolean 
exclusive OR operation on each bit of its integer 
arguments. Exclusive OR means that either operand 
one is true or operand two is true, but not both. 

(A ^ B) is 1. 

~ Called Bitwise NOT Operator. It is a unary operator and 
operates by reversing all bits in the operand. 

(~B) is -4. 

<< Called Bitwise Shift Left Operator. It moves all bits in 
its first operand to the left by the number of places 
specified in the second operand. New bits are filled 
with zeros. Shifting a value left by one position is 
equivalent to multiplying by 2, shifting two positions is 
equivalent to multiplying by 4, etc. 

(A << 1) is 4. 

>> Called Bitwise Shift Right with Sign Operator. It moves 
all bits in its first operand to the right by the number of 
places specified in the second operand. The bits filled 
in on the left depend on the sign bit of the original 
operand, in order to preserve the sign of the result. If 
the first operand is positive, the result has zeros 
placed in the high bits; if the first operand is negative, 
the result has ones placed in the high bits. Shifting a 

(A >> 1) is 1. 
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value right one place is equivalent to dividing by 2 
(discarding the remainder), shifting right two places is 
equivalent to integer division by 4, and so on. 

>>> Called Bitwise Shift Right with Zero Operator. This 
operator is just like the >> operator, except that the 
bits shifted in on the left are always zero, 

(A >>> 1) is 1. 

 

The Assignment Operators: There are following assignment operators supported by 
JavaScript language: 

Operator Description Example 

= Simple assignment operator, Assigns values from right 
side operands to left side operand 

C = A + B will 
assigne value 
of A + B into C 

+= Add AND assignment operator, It adds right operand to 
the left operand and assign the result to left operand 

C += A is 
equivalent to  
C = C + A 

-= Subtract AND assignment operator, It subtracts right 
operand from the left operand and assign the result to left 
operand 

C -= A is 
equivalent to  
C = C - A 

*= Multiply AND assignment operator, It multiplies right 
operand with the left operand and assign the result to left 
operand 

C *= A is 
equivalent to  
C = C * A 

/= Divide AND assignment operator, It divides left operand 
with the right operand and assign the result to left 
operand 

C /= A is 
equivalent to  
C = C / A 

%= Modulus AND assignment operator, It takes modulus 
using two operands and assign the result to left operand 

C %= A is 
equivalent to  
C = C % A 

 

Miscellaneous Operator 

  The Conditional Operator (? :) 

There is an operator called conditional operator. This first evaluates an expression 
for a true or false value and then execute one of the two given statements depending 
upon the result of the evaluation.  

Operator Description Example 

? : Conditional Expression If Condition is true? 
Then value X: 
Otherwise value Y 
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  The Type of Operator 

The type of is a unary operator that is placed before its single operand, which can be 
of any type. Its value is a string indicating the data type of the operand. 

The type of operator evaluates to "number", "string", or "boolean" if its operand is a 
number, string, or boolean value and returns true or false based on the evaluation. 

Here is the list of return values for the type of Operator: 

Type String Returned by Type of 

Number "number" 

String "string" 

Boolean "boolean" 

Object "object" 

Function "function" 

Undefined "undefined" 

Null "object" 

Data Types 
A data type is a classification of the type of data that a variable or object can hold. Data 
type is an important factor in virtually all computer programming languages, including 
visual basic, C#, C/C++ and JavaScript. When programmers create computer applications, 
both desktop and web-based, data types must be referenced and used correctly to ensure 
the result of the application's functions is correct and error-free. There are various data 
types discussed in details as given below: 

Numbers 

Numbers in JavaScript are double-precision 64-bit format. The standard numeric 
operators are supported, including addition, subtraction, modulus (or remainder) arithmetic 
and so forth. There's also a built-in object called Math to handle more advanced 
mathematical functions and constants.  

Syntax: var num=new Number(value); 

We can convert a string to an integer using the built-in parseInt() function. This takes the 
base for the conversion as an optional second argument, which you should always 
provide: 

parseInt("123", 10) 

123 
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parseInt("010", 10) 

10 

If you don't provide the base, you can get surprising results in older browsers: 

parseInt("010") 

8 

It happens because the parseInt() function decided to treat the string as octal due to the 
leading 0. 

If you want to convert a binary number to an integer, just change the base: 

parseInt("11", 2) 

3 

Similarly, we can parse floating point numbers using the built-in parseFloat() function 
which uses base 10 . 

You can also use the unary + operator to convert values to numbers: 

+ "42" 

42  

A special value called NaN (short for "Not a Number") is returned if the string is non-
numeric: 

parseInt("hello", 10) 

NaN 

NaN is toxic: If we provide it as an input to any mathematical operation the result will also 
be NaN, 

NaN + 5 

NaN 

We can test for NaN using the built-in isNaN() function: 

isNaN(NaN) 

true 

JavaScript also has the special values +Infinity and -Infinity: 

+1 / 0 

+Infinity 

-1 / 0 

-Infinity 
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We always can test for +Infinity, -Infinity and NaN values using the built-in isFinite() 
function: 

         isFinite(1/0) 
            false 
         isFinite(-Infinity) 
             false 
         isFinite(NaN) 
             false 

Note: The parseInt() and parseFloat() functions parse a string until they reach a character 
that isn't valid for the specified number format, then return the number parsed up to that 
point. However the "+" operator simply converts the string to NaN if there is any invalid 
character in it.  

Strings 

Strings in JavaScript are sequences of characters. More precisely, they're sequences of 
Unicode characters, with each character represented by a 16-bit number. If we want to 
represent a single character, we just need to use a string of length 1. 

To find the length of a string, access its length property: 

"hello".length 
5                                                                                           //length of given string “hello” 

The strings are represented using objects and they have methods as well: 

"hello, world".replace("hello", "goodbye")  //by using replace() method 
goodbye, world 
"hello".toUpperCase()                                          //by using toUpperCase() method 
HELLO 

Other types 

JavaScript distinguishes between null, which is an object of type 'object' that indicates a 
deliberate non-value, and undefined, which is an object of type 'undefined' that indicates 
an uninitialized value.  

In JavaScript it is possible to declare a variable without assigning a value to it. If we do 
this, the variable's type is undefined. 

JavaScript has a boolean type, with possible values true and false (both of which are 
keywords). Any given value can be converted to a boolean according to the following 
rules: 

1) false, 0, the empty string (" "), NaN, null, and undefined all become false 

2) all other values become true 
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You can perform this conversion explicitly using the boolean() function: 

  boolean("") 

false 

  boolean(234) 

true 

Variables 

New variables in JavaScript are declared using the var keyword: 

var a; 
var name = "Student_Name"; 

If we declare a variable without assigning any value to it, by default its type is undefined.  

Note: An important difference from other languages like Java is that in JavaScript, blocks 
do not have scope; only functions have scope. So if a variable is defined using var in a 
compound statement (like inside an if control structure), it will be visible to the entire 
function. 

Control Structures 

JavaScript has a similar set of control structures similar to other languages like C\C++ and 
Java. Conditional statements are supported by if and else, 

var name = "kittens"; 

if (name == "puppies") { 

  name += "!"; 

} else if (name == "kittens") { 

  name += "!!"; 

} else { 

  name = "!" + name; 

} 

name == "kittens!!" 

JavaScript has while loops and do-while loops. The first is good for basic looping; the 
second for loops  to ensure that the body of the loop is executed at least once: 

while (true) 

 { 

  // an infinite loop! 

  } 

var input; 
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do 

 { 

  input = get_input(); 

} while (inputIsNotValid(input)) 

JavaScript's for loop is the same as that in C\C++ and Java which provides the control 
information for the loop on a single line. 

for (var i = 0; i < 5; i++)  

{ 

  // this loop will execute 5 times 

} 

The && and || operators are logical operators i.e., they will execute their second operand 
dependent on the first. This is useful for checking null objects before accessing their 
attributes: 

var name = o && o.getName(); 

Or for setting default values: 

var name = otherName || "default"; 

JavaScript has a ternary operator for conditional expressions: 

var allowed = (age > 18) ? "yes" : "no"; 

The switch statement can be used for multiple branches based on a number or string: 

switch(action) { 

    case 'draw': 

        drawit(); 

        break; 

    case 'eat': 

        eatit(); 

        break; 

    default: 

        donothing(); 

} 

If  we don't add a break statement, execution will "fall through" to the next level. In fact it's 
worth specifically labelling deliberate fallthrough with a comment : 

switch(a) 
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 { 

    case 1: // fallthrough 

    case 2: 

        eatit(); 

        break; 

    default: 

        donothing(); 

} 

The default clause is optional. We can have expressions in both the switch part and the 
cases, comparisons take place between the two using the “==” operator: 

switch(1 + 3) 

 { 

    case 2 + 2: 

        yay(); 

        break; 

    default: 

        neverhappens(); 

} 

Objects 

JavaScript objects are simply collections of name-value pairs. The "name" part is a 
JavaScript string, while the value can be any JavaScript value including more objects.  

There are two basic ways to create an empty object: 

var obj = new Object( );  and  var obj = { }; 

These are semantically equivalent, the second is called object literal syntax, and is more 
convenient. Once created, an object's properties can again be accessed in one of two 
ways: 

obj.name = "Simon"; 

var name = obj.name; 

And... 

obj["name"] = "Simon"; 

var name = obj["name"]; 
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These are also semantically equivalent. The second method has the advantage that the 
name of the property is provided as a string, which means it can be calculated at run-
time.It can also be used to set and get properties with names that are reserved words: 

obj.for = "Simon";             // Syntax error, because 'for' is a reserved word 

obj["for"] = "Simon";      // works fine 

Object literal syntax can be used to initialise an object : 

var obj = {  

 name: "Carrot", 

 "for": "Max", 

    details: { 

        color: "orange", 

        size: 12 

    } 

} 

Attribute access can be chained together: 

To find the color of the given object, 

     obj.details.color 

Output: Orange 

To get the size of the given object, 

     obj["details"]["size"] 

Output: 12 

Arrays 

Arrays in JavaScript are actually a special type of object. They work similar to regular 
objects but they have one magic property called 'length'. The length of the array (size of 
the array) is always one more than the highest index in the array. The traditional way of 
creating arrays is as follows: 

Example: 

   var a = new Array(); 

   a[0] = "dog"; 

   a[1] = "cat"; 

   a[2] = "hen"; 

   a.length 



 72 

Output: 3 

A more convenient notation can be used while dealing with arrays: 

Example:- 

var a = ["Apple", "Mangoes", "Orange", “Banana”]; 

  a.length               

Output: 4 

Note: Leaving a trailing comma at the end of an array literal is inconsistent across 
browsers, so don't do it. The length of the array is one more than the highest index. 
However, the array.length isn't necessarily the number of items in the array.  

Example: 

 var a = ["dog", "cat", "hen"]; 

 a[100] = "fox"; 

 a.length 

Output: 101 

If we query a non-existent array index, we get undefined, 

Example: 

typeof a[90] 

Output:  undefined 

If  we take the above example into account, we can iterate over an array using the 
following: 

for (var i = 0; i < a.length; i++) 

 { 

    // Do something with a[i] 

} 

Arrays and string come with a number of methods: 

Method Name Description 

substring() Extracts the characters from a string, between two specified indices 

concat() Joins two or more strings, and returns a copy to the joined strings 

join() Joins all elements of an array into a string 

pop() Removes and returns the last item. 

push() Push adds one or more items to the end. 

reverse() Reverses the order of an element  in an array 
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shift() Removes the first element of an array and returns that element 

slice() Returns a sub-array. 

sort() Takes an optional comparison function. 

splice() Modify an array by deleting a section and replacing it with more items. 

unshift() Prep ends items to the start of the array. 
 

3.2   Functions 
Functions are the core component for understanding JavaScript. A simple basic function 
can be declared as: 

function add(x, y) { 
    var total = x + y; 
    return total; 
} 

A JavaScript function can take 0 or more named parameters. The function body can 
contain as many statements and can declare its own variables which are local to that 
function. The return statement can be used to return a value at any time, or terminating the 
function. If no return statement is used (or an empty return with no value) JavaScript 
returns undefined. 

We can call a function without passing the parameters it expects, in which case they will 
be set to undefined. 

  add() 
NaN                                         // We can't perform addition on undefined 
  add(2, 3, 4) 
5                                           // added the first two; 4 was ignore 

Functions have access to an additional variable inside their body called arguments, which 
is an array-like object holding all of the values passed to the function. Let's re-write the 
add function to take as many values: 

function add() { 

    var sum = 0; 

    for (var i = 0, j = arguments.length; i < j; i++) { 

    sum += arguments[i]; 

  } 

    return sum; 

  } 



 74 

Output: 

add(2, 3, 4, 5)    

14 

That's really not any more useful than writing 2 + 3 + 4 + 5 though. Let's create an 
averaging function: 

function avg() { 

    var sum = 0; 

    for (var i = 0, j = arguments.length; i < j; i++) { 

    sum += arguments[i]; 

    } 

    return sum / arguments.length; 

} 

Output: 

 avg(2, 3, 4, 5) 

3.5 

In this example,  avg() function takes a comma separated list of arguments — but if we 
want to find the average of an array we could just write the function as follows: 

function avgArray(arr) { 

    var sum = 0; 

    for (var i = 0, j = arr.length; i < j; i++)  

   { 

    sum += arr[i]; 

    } 

    return sum / arr.length; 

    } 

Output: 

avgArray([2, 3, 4, 5]) 

3.5 

JavaScript allows reusability feature by calling a function with an arbitrary array of 
arguments, using the apply() method of any function object. 

Output: 

avg.apply(null, [2, 3, 4, 5]) 

3.5 



 75 

JavaScript allows us to create anonymous functions. 

var avg = function() { 

var sum = 0; 

 for (var i = 0, j = arguments.length; i < j; i++) { 

 sum += arguments[i]; 

 } 

 return sum / arguments.length; 

 } 

This is semantically equivalent to the function avg() form.  

JavaScript allows us to call functions recursively. This is particularly useful for dealing with 
tree structures, such as we get in the browser DOM (Document Object Model). 

function count Chars(elm)  

 { 

    if (elm.nodeType == 3) {                                     // TEXT_NODE 

    return elm.nodeValue.length; 

  } 

    var count = 0; 

    for (var i = 0, child; child = elm.childNodes[i]; i++) { 

    count += count Chars(child); 

  } 

    return count; 

  } 

Inner Functions 

JavaScript function declarations are allowed inside other functions.  An important feature 
of nested functions in JavaScript is that they can access variables in their parent function's 
scope: 

function betterExampleNeeded() { 

    var a = 1; 

    function oneMoreThanA() { 

     return a + 1; 

    } 

    return oneMoreThanA(); 

    } 
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List of Some Common Programs Using JavaScript  

A Simple Program: Printing a Line of Text in a Web Page Using JavaScrip 

<html> 

<body> 

(h1>my first web page</h1> 

<script> 

Document.write(“Hello World!”) 

</script> 

</body> 

</html> 

Output: 

 
Figure – 3.1 

Variables: JavaScript variables are “containers” for storing information. Creating a 
variable is most often referred to as “declaring” a variable. 

  To declare variables, use the keyword var and the variable name: 

 var username. 
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  To assign values to variables, add an equal sign and the value: 
        var userName = "JOHN" 

                      var price = 50 

Example: 

//Program to show date and time. This is a comment line.  
<html> 
<body> 
<script> 
var d=new Date(); 
document.write(d); 
</script> 
</body> 
</html> 

Output: 

 
Figure – 3.2 

Functions - Predefined 
A function is a block of code that will be executed when someone calls it. With functions, 
you can give a name to a whole block of code, allowing you to reference it from anywhere 
in your program. JavaScript has built-in functions for several predefined operations. Here 
are three some functions. 
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  alert("message") 
  confirm("message") 
  prompt("message”) 

Example: Alertbox 
//Program to show the alertbox. 
<html> 
<head> 
<script> 
function myFunction() 
{ 
alert("HELLO!"); 
}  
</script> 
</head> 
<body> 
<input type="button"onclick="myFunction()"value="show me the alert box"/> 
</body> 
</html> 

Output: 

 
Figure – 3.3 
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//Program to show the confirm box. 
<html> 
<head> 
<p>Click the button to display a confirm box.</p> 
<button onclick="myFunction()">try it</button> 
<p id="demo"></p> 
<script> 
function myFunction() 
{var x; 
var r=confirm("press a button"); 
if(r==true) 
{ 
x="you pressed OK"; 
} 
else 
{ 
x="you pressed cancel"; 
} 
document.getElementById("demo").innerHTML=x; 
} 
</script> 
</body> 
</html> 

Output: 

 
Figure – 3.4 
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Output continues……. 

 
Figure – 3.5 

//Program to show the prompt box. 
<html> 
<body> 
<p><strong>Click the button to demonstrate the prompt box.</strong></p> 
<button onclick="myFunction()">try it</button> 
<p id="demo"></p> 
<script> 
function myFunction() 
{ 
var x; 
var person; 
person=prompt("please enter your name"," "); 
if(person!=null) 
{  
x=("hello" +person+ "!how are u today?"); 
} 
document.getElementById("demo").innerHTML=x; 
} 
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</script> 
</body> 
</html> 

  Output: 

 
Figure – 3.6 

Output continues….. 

 
Figure – 3.7 
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Functions – User Defined 

With user-defined functions, you can name a block of code and call it when you need it. 
You define a function in the HEAD section of a web page. It is defined with the function 
keyword, followed by the function name and any arguments. 

function functionName(argument) 
{ 
statements 
}    
//Program to call a function. 
<html> 
<head> 
<script> 
function myFunction() 
{ 
confirm("Welcome!!!"); 
} 
</script> 
</head> 
<body> 
<button onclick="myFunction()">try it</button> 
<p><strong>By clicking the above button,a function will be called.The function will confirm 
a message.</strong></p> 
</body> 
</html> 

Output: 

 
Figure – 3.8 
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//Program to show function with an argument. 
<html> 
<body> 
<p>click the button to call a function with arguments</p> 
<button onclick="myFunction('The Earth','around the Sun')">try it</button> 
<script> 
function myFunction(name,object) 
{ 
alert(name+"revolves"+object); 
} 
</script> 
</body> 
</html> 

Output: 

 
Figure – 3.9 
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//Function that returns a value. 
<html> 
<head> 
<script> 
function myFunction() 
{ 
return("Have a nice day!!!"); 
} 
</script> 
</head> 
<body> 
<script> 
document.write(myFunction()); 
</script> 
</body> 
</html> 

Output: 

 
Figure – 3.10 
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//Function with arguments that returns a value. 
<html> 
<body> 
<p>Function with arguments that returns the result</p> 
<p id="demo"></p> 
<script> 
function myFunction(x,y) 
{ 
return x+y; 
} 
document.get ElementById("demo").innerHTML=myFunction(5,8); 
</script> 
</body> 
</html>                   

Output: 

 
Figure – 3.11 
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3.3  Objects 
 JavaScript supports programming with objects. Objects are a way of organizing the 

variables. The different screen elements such as Web pages, forms, text boxes, images, 
and buttons are treated as objects. 

Properties and Methods 
Every object has its own properties and methods. 

  Properties define the characteristics of an object. Examples are color, length, name, 
height, width etc. 

  Methods are the actions that the object can perform or that can be performed on the 
object. Examples are alert, confirm, write, open, close etc. 

Naming Objects 
  Objects are organized in a hierarchy: to refer to an object use object Name 

  To refer to a property of an object use: object Name. property Name 

  To refer to a method of an object use: object Name. method Name() 

Built-In Objects 
Some of the built-in language objects of JavaScript offer more advanced operations such 
as: 

  String – provides for string manipulation, 

  Math-provides for maths calculations, 

  Array-provides the collection of similar data types. 

3.4  String Object 
 The String object provides methods and properties for string manipulation and formatting. 

Format: stringName.method() 
//Program to find the length of the array 
<html> 

<body> 
<p>Length of the given string = 
<script> 
var txt="Hello world"; 

document.write(txt.length); 
</script> 
</p> 

</body> 
</html> 
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Output: 

 
Figure – 3.12 

//Program to find the position of the first occurrence of a text in a string using indexOf() 
<html> 
<body> 
<p id="demo"><strong>click the button to locate where in the string a specified value 
occurs.</strong></p> 
<button onclick="myFunction()">try it</button> 
<script> 
function myFunction() 
{ 
var str="hello! welcome to my world"; 
var n=str.indexOf("world"); 
document.getElementById("demo").innerHTML=n; 
} 
</script> 
</body> 
</html> 
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Output: 

 
Figure – 3.13 

Output continued……. 

 
Figure – 3.14 
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//Program to search for a text in a string and return the text if found using match() 

<html> 

<body> 

<script> 

var str="Honesty is the best policy"; 

document.write(str.match("policy")+"<br>"); 

document.write(str.match("Police")+"<br>"); 

document.write(str.match("pollicy")+"<br>"); 

document.write(str.match("policy")+"<br>"); 

</script> 

</body> 

</html> 

Output: 

 
Figure – 3.15 
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//Program to replace characters in a string using replace() 

    <html> 

<body> 

<p>click the button to replace the characters</p> 

<p id="demo">hello prachi</p> 

<button onclick="myFunction()">try it</button> 

<script> 

function myFunction() 

{ 

var str=document.getElementById("demo").innerHTML; 

var n=str.replace("hello","good morning"); 

document.getElementById("demo").innerHTML=n; 

} 

</script> 

</body> 

</html> 

Output: 

 
Figure – 3.16 
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When we click the button the output will be…… 

 
Figure – 3.17 

3.5  Math Object 

 The Math object provides methods for many mathematical calculations like abs(), log(), 
pow(), random(), round(), sqrt() etc. 

 Format: Math.method(#) 

  round() method 

The round() method returns a number to the nearest integer. 

Syntax: 

                      Math.round() 

//Program to round off any number using round() 

<html> 

<body> 

<p id="demo">click the button to round the no.to its nearest integer.</p> 



 92 

<button onclick="myFunction()">try it</button> 

<script> 

function myFunction() 

{ 

document.getElementById("demo").innerHTML=Math.round(8.7896); 

} 

</script> 

</body> 

</html>    

Output: 

 
Figure – 3.18 
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Output continues…. 

 
Figure – 3.19 

  random() 

The random() method returns a random number from 0(inclusive) up to but not 
including 1(exclusive). 

Syntax: 

          Math.random() 

//Program to return a value random number between 0 and 1 using random() 

<html> 

<body> 

<p id="demo">click the button to display a number</p> 

<button onclick="myFunction()">try it</button> 

<script> 
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function myFunction() 

{ 

document.getElementById("demo").innerHTML=Math.random(); 

} 

</script> 

</body> 

</html>  

Output: 

 
Figure – 3.20 

Output continues……. 

On pressing try it key continuously we got various random numbers 
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Figure – 3.21 

  max() 

The max() method returns the number with the highest value. 

Syntax: 

               Math.max(n1,n2,n3……..nx) 

//Program to return the number with highest value of two specified  numbers using 
max() 
<html> 
<body> 
<p id="demo">Click the button to return the highest no. between 5 and 10.</p> 
<button onclick="myFunction()">try it</button> 
<script> 
function myFunction() 
{ 
document.getElementById("demo").innerHTML=Math.max(5,10); 
} 
</script> 
</body> 
</html> 
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Output: 

 
Figure – 3.22 

 
Figure – 3.23 
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  min() 

The min() method returns the number with the lowest value. 

Syntax:    

            Math.min(n1,n2,n3……….nx) 

//Program to return the number with the lowest value of two specified number using 
min(). 

<html> 

<body> 

<p id="demo">Click the button to return the lowest no. between 77 and 9.</p> 

<button onclick="myFunction()">try it</button> 

<script> 

function myFunction() 

{ 

document.getElementById("demo").innerHTML=Math.min(77,9); 

} 

</script> 

</body> 

</html> 

Output: 

 
Figure – 3.24 
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Output continues…… 

 
Figure – 3.25 

3.6   Array object:     

 The array object is used to store multiple values in a single variable.                                                     

//Program to create an array. 

<html> 

<body> 

<script> 

var i; 

var fruits=new Array(); 

fruits[0]="apple"; 

fruits[1]="banana"; 

fruits[2]="orange"; 

for(i=0;i<fruits.length;i++) 
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{ 

document.write(fruits[i]+"<br>"); 

} 

</script> 

</body> 

</html> 

Output: 

 
Figure – 3.26 

//Program to join two arrays using concat(). 

<html> 

<body> 

<p id="demo">Click the button to join three arrays</p> 

<button onclick="myFunction()">Click me</button> 
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<script> 

function myFunction() 

{ 

var fruits=["Apple","Orange"]; 

var vegetables=["Cucumber","Carrot","Raddish"]; 

var grains=["Wheat","Maize"]; 

var mix=fruits.concat(vegetables,grains); 

var x=document.getElementById("demo"); 

x.innerHTML=mix; 

} 

</script> 

</body> 

</html> 

Output: 

 
Figure – 3.27 
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Output continues…….. 

 
Figure – 3.28 

//Program to remove the last element from the array by using pop() 

<html> 

<body> 

<p id="demo">Click the button to remove the last array element.</p> 

<button onclick="myFunction()">Click me</button> 

<script> 

var name=["John","Mary","Oliver","Alice"]; 

function myFunction() 

{ 

name.pop(); 

var x=document.getElementById("demo"); 

x.innerHTML=name; 

} 

</script> 

</body> 

</html> 
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Output: 

 
Figure – 3.29 

 
Figure – 3.30 
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//Program to add a new element to the array using push(). 

<html> 

<body> 

<p id="demo">Click the button to add a new element to the array.</p> 

<button onclick="myFunction()">Click me</button> 

<script> 

var name=["Alice","Henry","John","Leo"]; 

function myFunction() 

{ 

name.push("Aayush"); 

var x=document.getElementById("demo"); 

x.innerHTML=name; 

} 

</script> 

</body> 

</html> 

Output: 

 
Figure – 3.31 
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Output continues on clicking the button……….. 

 
Figure – 3.32 

//Program to reverse the order of the elements in the array. 

<html> 

<body> 

<p id="demo">Click the button to reverse the order of the element in the array.</p> 

<button onclick="myFunction()">Click me</button> 

<script> 

var alphabet=["z","k","j","h","e"]; 

function myFunction() 

{ 

alphabet.reverse(); 

var x=document.getElementById("demo"); 

x.innerHTML=alphabet; 

} 

</script> 

</body> 

</html> 
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Output: 

 
Figure – 3.33 

Output continues…… 

 
Figure – 3.34 
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//Program to sort the array. 
<html> 
<body> 
<p id="demo">Click the button to sort the array</p> 
<button onclick="myFunction()">Click me</button> 
<script> 
function myFunction() 
{ 
var fruits=["Banana","Orange","Apple","Mango"]; 
fruits.sort(); 
var x=document.getElementById("demo"); 
x.innerHTML=fruits; 
} 
</script> 

</body> 

</html> 

Output: 

 
Figure – 3.35 
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Output continues…… 

 
Figure – 3.36 

3.7 Events 

 The objects in Web pages are organized in a hierarchical structure. All objects have 
properties and methods. In addition, some objects also have "events". Events are things 
that happen, usually user actions that are associated with an object. The "event handler" is 
a command that is used to specify actions in response to an event. Below are some of the 
most commonly used events: 

 onLoad            -   occurs when a page loads in a browser 

 onUnload         -   occurs just before the user exits a page 

 onMouseOver  -   occurs when you point to an object 

 onMouseOut   -   occurs when you point away from an object 

 onSubmit        -   occurs when you submit a form 

 onClick           - occurs when an object is clicked 

//Execution of javascript immediately after a page has been loaded. 

<html> 

<head> 

<script> 
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function myFunction() 

{ 

confirm("Welcome to the loaded browser"); 

} 

</script> 

</head> 

<body onload="myFunction()"> 

<h1>Event handling!</h1> 

</body> 

</html> 

Output: 

 
Figure – 3.37 
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//Execute a javascript when a button is clicked. 

<html> 

<head> 

<script> 

function myFunction() 

{ 

document.getElementById("demo").innerHTML="Hello World"; 

} 

</script> 

</head> 

<body> 

<p>Click the button</p> 

<button onclick="myFunction()">Click me</button> 

<p id="demo"></p> 

</body> 

</html> 

Output: 

 
Figure – 3.38 
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3.8   Case Studies  

 Case Study I: Online Shopping  

 In this section we consider the scenario of online shopping web-site. Online shopping 
deals with purchasing products or services over the Internet any time anywhere. Online 
shopping or e-shopping is a form of electronic business which allows consumers to directly 
buy goods or services from a seller over the Internet using a web browser. Alternative 
names are: e-web-store, e-shop, e-store, Internet shop, web-shop, web-store, online store, 
online storefront and virtual store. Online shopping has grown in popularity over the years, 
mainly because people find it convenient and easy to bargain shop from the comfort of 
their home or office. The students can use the concept of Java Script for designing a 
commercial web-site. Students may design the online web-site with the following 
specifications: 

  Create a home page using java scripts specifying login page and products details. 
The home page includes details of the user account with products details and 
description of items and their availability with price tags and discounts if any (for 
some specific offer).  

  Either user can login or register to the websites as per the choice of shoppers/users. 

  For Registration page javascript will be used – which will check for user validation 
such as having a valid e-mail_id to check the authenticity of the user.  

  After login page – link the other pages with home page which will display about 
products and transaction details.  

  A fresh session starts for each user after login for some specific time which will 
expires once you log out or leave the web page idle for some time.  

  User can select product for purchasing from product list provided on the home page.  

  After that the user will be redirected to payment page / online payment.  

  Payment can be done either using cash on delivery or e-payment (online transaction 
through some payment gateway i.e., Online bill pay is an electronic payment service 
that allows you to set up a secure online account to make one time or recurring bill 
payments for online transactions) 

  Generate a receipt for each transaction or combined transactions with payment 
details and item details to be dispatch to the user which can be used in case of 
transaction failure or if items not received with desired descriptions as per the user’s 
requirements.  

  Host the web-site.  
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Case Study – II: Designing a Web-site for your School 

One of the most important steps involved in creating a school web site is deciding what 
content will be included and how it will be organized. Building a school web site provides a 
unique addition to the curriculum. In the development phase, students and teachers 
should discuss the kinds of materials they want to add to the site. Students may consider 
the following issues while designing web-site for your own school. 

  School Information: General information such as the school’s telephone number 
and address along with driving directions should be included. Making mention of the 
school boundaries is also useful. The school’s history, mission statement, and 
awards received are interesting and serve to promote a feeling of community. The 
names of the administration and faculty along with their school email addresses may 
also be added. Other information about the office hours, the bell and bus schedules, 
and after-school care may also be included.  

  School Policy: The school policy is a very important document that may be made 
readily available by posting it on the school site. School policy information might 
include use of the Web in school, admission procedures / requirements, dress code, 
absences, and behaviour expectations. Publishing school policies on your site can 
help increase awareness and access to this information. 

  Calendar of Events: A calendar of events provides parents, teachers and students 
with an easy way to keep up-to-date with the happenings at the school. Special 
events such as school plays, sports, field trips, and standardized tests are just a few 
examples of what may be included. The school lunch menu may be added to the 
calendar as well. Calendars are easily updated each month and this method of 
showing events cuts down on the amount of paper and printing that needs to be 
done. In addition, parents can always have access to the most recent calendar 
without worrying about it becoming lost.  

  Extracurricular Activities: School clubs or organizations involved in organizing 
special events may create their own pages describing their purposes and anticipated 
activities for the entire year. Meeting and event schedules with detailed information 
are useful for informing students and gaining their interest.  

  Newsletters: Newsletters written by the students are another great way to relay 
information about the school. Students may submit articles, reports on class trips, 
and special school events. Involving students gives them a chance to share their 
thoughts in writing and build school spirit. A message from the principal that provides 
motivation and encouragement to students and promoters parents involvement may 
be included.  

  Parent Involvement: An excellent way to encourage parent involvement is to keep 
them informed of opportunities such as volunteering, PTA meetings, and fundraising 
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activities. By providing a wide range of choices, the school can help parents find the 
activities that fit their time and schedule constraints as well as their interests.  

  Links: There are many excellent resources available on the Web for teachers, 
students and parents. Providing links to some of these sources is very helpful. Be 
sure to check the links periodically to make sure the resources are still available. 
Teachers can have easy access to learning communities and lesson plan ideas. 
Students can link to reference or ask-an-expert sites and sites with virtual museums. 
Links of interest to parents can also be included.  

Exercise:   

Q1. Define the characteristics of JavaScript? Is java and java script both are similar? 
Write the difference between both of them. 

Q.2. Point the errors in the following code and write the corrected script: 

 <SCRIPT LANG="JavaScript">  

 var A=10;  

 var B=6;  

 switch A%B  

 {  

 case 0;  

 document.write("The input is:");  

 break;  

 case 1;  

 document.write("The colour is:")  

 break;  

 else;  

 document.write("You didn't choose")  

 }  

 </SCRIPT>  

Q3. Give the output of the following code segment:  

 <BODY>  

 <SCRIPT LANGUAGE="JavaScript">  

 var sum = new Array(6);  

 var Total = 0;  

 sum[0] = 0;  
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 for(var icount = 1; icount < 4; icount++)  

 {  

 Total += icount;  

 sum[icount] = Total;  

 document.write(sum[icount]+"<br>");  

 }  

 document.write(Total);  

 </SCRIPT>  

 </BODY>  

Q4 (a) Explain the functions and arrays in javascript with example? 

 (b) How the forms are handled in javascript? Explain. 

Q5. How can javascript make a website easier to use? That is, are there certain 
javascript techniques that make it easier for people to use a website? 

Q6. How do you convert numbers between different bases in javascript? 

Q7. How do we get javascript on a web page explain? 

Q.8 Write a program in javascript using various data types to find the round off integer 
values? 

Q9. Write the program in javascript to solve the given polynomial: 

x3 + 2x2.y + 3x.y2 + y3 = 0                                   

Q10. Design a home page of your school. Include some images/pictures and other events 
of an academic calendar for session 2013-2014. Also include some audio/video 
features to make your web-site more interactive. 
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Chapter - 4: Advanced Features of  
       Web - Design  

 

4.1  Code View, Add-Ins, Snippets ad Page Transitions  

 Working with CODE View 

 Though most tasks can be completed using GUI, at times you may have to insert code 
manually (for example when you want to integrate with your website, a third party web 
application, provided as code). 

 IntelliSense is a feature that automatically provides you a list of codes and attributes as a 
popup when you work in the code view mode. To understand how to use it, do the 
following: 

1) Create a new HTML page.  

2) Select Code View.  

3) Place the cursor after the <body> tag.  

4) Type angle bracket < to open the tag. Notice the list of elements displayed (image 
below).  

5) Select a element from the list, for example: h1.  

6) Now place the cursor after the element and press spacebar. Notice the list of attribute 
related to this element is displayed. Select align, (notice the attribute added), select = 
on your keyboard. Notice the value corresponding to this attribute is selected. Select 
Center.  

7) Close the tag using >. Notice the end tag is automatically added.  

 Though code view can be difficult to use in the beginning, once you have adequate 
practice, you will gain total control of the coding environment! 

 To view IntelliSense settings, do the following: 

1) Select Tools > Page Editor Options….  

2) Select the tab IntelliSense.  
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Figure-4.1 

3) Notice the settings. Note that you need additional technical expertise to work with this 
area. Do NOT change any setting here.  

Add-ins 

Add-ins extends the capability of the main program by adding enhanced custom 
commands and specialized features. You can download a variety of Add-ins from: 

  http://msdn.microsoft.com/en-us/expression/jj873995.aspx  

  http://www.webassist.com/go/xweb-add-ins  

  http://www.expressionextras.com/products/lightbox.htm  

  http://www.dotnetcurry.com/ShowArticle.aspx?ID=534  

  Of Course, Use Google to find more Add-ins!  

Once you have downloaded an Add-in, use the following procedure to install the Add-in: 

1) Select Tools > Add-ins. The Manage Add-ins dialog box appears.  

2) Select Install…. Browse and select the Add-in and then click Open.  

3) Select Yes.  

4) Repeat the procedure to include more Add-ins.  

Note: Add-ins may need to be installed through a special procedure. Refer to Add-ins help 
file for detailed instructions. 

http://msdn.microsoft.com/en-us/expression/jj873995.aspx
http://www.webassist.com/go/xweb-add-ins
http://www.expressionextras.com/products/lightbox.htm
http://www.dotnetcurry.com/ShowArticle.aspx?ID=534
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Using Snippets 

Snippets are pieces of programs re-used by most developers. Snippets are useful as you 
can keep reusing the code created many times across multiple web pages or web sites 
saving enormous amount of time and effort. To view and insert the available snippets, do 
the following: 

1) Select Panels > Snippets. Notice the list of snippets available separated into 
categories such as CSS, HTML, JavaScript, JQuery, etc.  

 
Figure-4.2 

2. To insert a snippet, do the following:  
a) Create a new page. Place the cursor where you want the snippet to be placed.  
b) Select View > Page > Code. (Snippets can be inserted only in Split or Code 

View).  
c) Expand HTML, expand Hyperlink folder.  
d) Double-click on a snippet, for example: Add to favorites. Notice the code is 

added to the web page.  
e) Save and preview this page in browser (F12). Switch to MEW and see the source 

code.  

Note: You may require following additional instructions for some of the snippets listed 
here. Refer to the help file for detailed instructions. 

PSD Templates 

As a web designer, you need to create pages that are attractive and simple. Remember 
that along with showcasing content to a visitor and the design also needs to be pleasant, 
encouraging them to repeat their visit to the website. 

When it comes to Web design, you need to maintain a balance between visual design and 
code. Though it is possible to create simple web designs using standard HTML, it is 
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always a good practice to research on good designs. Components of some of the 
attractive websites are usually created using Adobe Photoshop and later integrated into 
the web site for additional functionality such as text content, forms, etc. 

You can import certain parts (or layers) or entire images into your website using MEW. 
Given here is a list of websites where you can find Photoshop templates (some of them 
are free!): 

  http://www.psdtemplates.com/templates/  

  http://www.freepik.com/free-psd/web-templates  

You can browse, select, download and use these files. Refer to website terms and 
conditions for license information. 

LINK PSD & MEW 

Also there is a special feature that can be used for updating an image whenever the 
original (.PSD) Photoshop image is modified. To understand how to use this feature, do 
the following: 

Import a .PSD (Photoshop files use this extension) file and do the following: 

1) Create a new web page, save the file as psd.html.  

2) Select File > Import > Adobe Photoshop (.psd)….  

3) Browse and select the file. Click Open. Import Adobe Photoshop File dialog box 
appears (figure below).  

 
Figure-4.3 

4) You can select the layers you want to import using the options in the left pane. Select 
Compatibility Image located at right bottom and click OK.  

http://www.psdtemplates.com/templates/
http://www.freepik.com/free-psd/web-templates
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5) Click Save when prompted.  

6) Right-click on the image, notice the menu item Adobe Photoshop (.psd) (figure 
below). 

 
Figure-4.4 

7) You can update this image whenever the original image is updated by selecting 
Update from Source…. This is possible because MEW maintains a link between the 
image and the original source. This is one feature that is useful for both web 
developers (who write code) and web designers (who design sites)!  

Page Transitions 

You can apply special effects to web pages just as in presentation software. This helps 
present special effects to visitors. 

To add transitions, do the following: 

1) Create a new page, save the file as trans.html.  

2) Select Format > Page Transition…. The Page Transitions dialog box appears 
(figure below).  

 
Figure-4.5 
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3) You need to select an event to which the effect should be applied. Select Site Enter 
from Event: dropdown and select Circle In from Transition effect: list.  

4) Type 5 in Duration (seconds): box and click OK.  

5) Save and preview this page in browser (F12). Switch to MEW and see the source 
code.  

Note: Page Transitions will work only on Internet Explorer 5.5 or above. 

Exercise: 
Perform the following activities till you are confident: 

S. No. Activities 

1. Download and use the following Add-ins: 

 a)   PayPal ecommerce Toolkit 

 b)   WordPaste Add-in 

 c)   Insert Bing Map Add-in 

 So think DHTML Menu Addon 

2. Include different snippets in web pages created in earlier sessions. 

3. Set the following transition effects for each  web page created in 

 earlier sessions: 

 a)   Random dissolve 

 b)   Blend 

 c)   Box Out 

 d)   Split horizontal in 
 

Assessment: 
Answer the following questions: 

Q1.  Explain the purpose of Add-ins.  

Q2.  List any three website that offer Add-ins for download (use Google).  

Q3.  Explain the purpose of snippets with an example.  

Q4.  Explain the procedure to import a PSD file with an example.  

Q5.  Explain the purpose of Page Transitions with an example.  

 Fill in the blanks: 
1. Add-ins is available _____ menu.  
2. Snippets can be accessed from ________ menu.  
3. PSD can be imported from _____ menu.  
4. Page Transitions is available _____ menu.  
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4.2   Dynamic Web Templates 

 Relevant Knowledge 

 Templates help you organize the entire website to have a consistent look and feel. This is 
very helpful when you work with large number of web pages. 

 On your website, you may have some common items displayed on all pages such as the 
logo, copyright & organization details, navigation menu, etc. but the content may vary on 
each page. Here, you can create a dynamic web template (DWT) with fixed positions for 
common elements and modifiable designated portions on each web page. 

 Unlike standard templates, Dynamic Web templates have the following features: 

1) When you update the DWT, all web pages in the website are automatically updated to 
changes.  

2) You can create multiple DWT and keep changing just the template that affects the 
entire website.  

3) You can allow only specific portions of the pages to be edited instead of whole web 
page resulting in better control and reduced chances of mistakes. This feature is very 
useful when multiple developers work on the same website.  

 Creating a Dynamic Web Template 

 To create a dynamic web template, do the following: 

1) Create a new web page (to be used as template).  

2) Add common elements such as a logo (picture), company name, copyright notice at 
the bottom of the web page, etc.  

3) You need to add editable regions and that will be the only area in which the content 
can be modified. To create editable region, do the following:  

a) Place the cursor where you need to place content (remember, this will be the 
only area where the content can be placed or changed). Right-click and select 
Manage Editable Regions…. The Editable Regions dialog box appears (figure 
below).  

b) Type a name, for example: Content. Click Add.  

c) Click Close.  
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Figure-4.6 

4. Select File > Save. Select Dynamic Web Template from the Save as type: 
dropdown menu (figure below). Type a file name, for example: MyTemplate and click 
Save  

 
Figure-4.7 

Using a Dynamic Web Template 

You have created a DWT template. If you want to create web page based on this 
template, do the following: 

1.   Select File > New > Create from Dynamic Web Template…. (figure below) 

 
Figure-4.8 
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2.  Notice the template displayed in the list. Select the template, for example: 
MyTemplate and click Open. A web page based on this template will be created and 
displayed. 

 
Figure-4.9 

3. Notice that you are able to type content only in the editable region specified earlier 
and rest of the area are not editable. Now type some content in the “Content” area. 
Save this page as a normal web page. For example,  

 Page01.html.  

4. Create at least 2-3 pages based on this DWT. Save the files.  
 

Editing a Dynamic Web Template 

When you edit the DWT, it automatically updates the changed layout to all the pages 
created using the DWT (for example, when you want to change to a different layout or 
update the company logo without affecting the content). To edit a DWT, do the following: 

1. Locate the Dynamic Web Template you created earlier (it will be displayed with the 
file extension .dwt) and double-click on it.  

2. Now add another editable region by placing the cursor elsewhere in the web page. 
Name the region as “Photos”.  

3. Now save this DWT (CTRL+S). Notice the message displayed (figure below).  

 
Figure-4.10 

4. Select Yes. Automatically all the web pages created using this template are updated.  

5. Open any of the web pages created using this template and notice the changes.  
6. Insert an image in the “Photo” region. Save the web page.  
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Sometimes you may have to use a completely different layout for entire website. In such 
cases you can create a new dynamic web template and associate all the web pages to this 
new DWT. This in turn will (in no time) apply the new structure to all the web page 
eliminating the need for making layout changes to each web page! 

To create a new DWT and associate all web pages (or selected web pages), do the 
following: 

1. Create a new DWT by swapping the “Content” and “Photos” regions:  

a) Create a region for “Photos” (at the top)  

b) Create a region for “Content” (below Photo)  

2. Save this as DWT with a new file name, example: MyTemplate02.  

Note: You need to include the region names as the content has to be retained but placed 
according to the new layout. Use the same region names when you want to work with 
different DWTs. Otherwise content may not swap properly leading to issues. 

Now, to use this new DWT, associate the web pages to the new template. 

1. Select all the web pages (Page0x.html) using the folder view (left pane). Use 
CTRL+Click to select multiple pages.  

2. Select Format > Dynamic Web Template > Attach Dynamic Web Template…  
(figure below).  

 
Figure-4.11 

3.   Attach Dynamic Web Template dialog box appears (figure below). 

 
Figure-4.12 
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4.   Select the second template, for example: MyTemplate02 and click Open. 

5. Notice the results displayed. Content from “Photos” and “Content” are automatically 
swapped based on the new template.  

Remove DWT association with selected or all web pages 

When you no longer need to use DWT or are using a HTML editor that may not have 
support for DWT, you can detach the DWT linked with selected or all web pages. 

Note this procedure only removes the relationship and is a one-way process. Content and 
the layout are left undisturbed. However if you want to associate with a DWT you need to 
start all over again! If you decide at some point to remove the relationship of DWT and 
selected or all web pages, do the following: 

1. Select all the web pages (Page0x.html) using the folder view (left pane).  

2. Select Format > Dynamic Web Template > Detach from Dynamic Web Template.  

3. Notice the message displayed, select Close.  

Exercise: 

Perform the following activities till you are confident: 

S. No. Activities 

1. 1. Create a dynamic web template using the following guidelines:  

  Use a table to link different pages in a website for navigating to other 
pages.  

  Use a table for the content area.  

  Insert copyright notice at the bottom and a hyperlink to the 
homepage (default.html) 

Assessment: 

Answer the following questions: 

Q1.  Explain the purpose of dynamic web template with an example.  

Q2.  Explain the procedure to link and remove DWT with multiple pages.  

Fill in the blanks: 

1. Acronym for DWT ___________________________.   

_____________________ from the Save as type: dropdown menu should be used for 
creating DWT.  
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4.3  SEO - Search Engine Optimization 

 Relevant Knowledge 

 Search Engine Optimization or SEO refers to the process that affects the website visibility 
or ranking when displaying search results. Search Engines search contents of a web page 
and create indexes to display results. As a web developer, you need to understand how 
search engines work and how to get better search ranking. SEO Checker built-in with the 
HTML Editor gives detailed reports that help you optimize the website for better ranking. 

 Anatomy of a Search Engine 

 Search engines crawl a website (and hence referred to as Spiders) to create index of 
content. This index helps find a matching web page or link based on keywords entered by 
visitors. 

 Search engines index the following components of a web page: 

1. Page Title (only the first 70 characters are displayed in search results!)  

2. Page Description (at least first 156 characters are displayed in search results!)  

3. Page Keywords  

4. Page headers (H1)  

5. Links to other pages  

6. Strong text (bold)  

7. Phrases  

8. ALT Text in images  

9. And many more….  

 Note: You need to learn more about SEO before taking decisions on optimizing a website. 
You need to refer to the SEO process of each search engine at their respective websites. 
However, you can use the SEO Checker to understand what needs to be optimized for a 
better ranking. 

1.   Select Tools > SEO Reports…. SEO Checker dialog box appears (figure below). 

 
Figure-4.13 
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2. Select All Pages, and the select Check .Notice the results (figure below). 

 
Figure-4.14 

You can click on each message displayed in the list to find out and fix related issues. 
For example for a message as “The Description is missing”, you can add a 
description using the META tags to correct it. Once errors are identified and fixed, run 
the SEO Checker again to confirm if the website is optimized. 

Exercise: 

Perform the following activities till you are confident: 

S. No. Activities 

1. Verify the website created earlier using SEO Checker. 
 

Assessment: 

 Answer the following questions: 

Q1.  Explain the purpose of SEO.  

Q2.  Explain the purpose of SEO Checker with an example.  

 Fill in the blanks: 

1. Acronym for SEO ____________________________________.  

2. SEO reports can access from _______ menu.  
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4.4  Forms - Advanced 

 Relevant Knowledge 

 So far, you have been using HTML and CSS for creating simple web pages. These are 
referred to as Static Web pages. While static web pages are good enough for creating 
basic web sites, you need to learn and use technologies such as ASP, PHP, etc. for 
creating dynamic websites. Dynamic Websites allow visitors to search and locate 
information (such as a search feature of search engines or database listing), submit 
information (such as feedback, rating, voting) etc. 

 Advanced Forms 

 You can create a fully functional form using MEW. Data filled using a form can be stored in 
a database or sent to a specific email address. But these features require proper support 
from the web hosting provider, primarily the support for FrontPage Server Extensions. 

Special Note: 

FrontPage Server Extensions is a technology that provides special functionalities on web 
servers created using Microsoft FrontPage or Microsoft Expression Web. Though this 
technology was used for over a decade, it is considered obsolete due to the evolution of 
other equivalent or better technologies. You may still find a few web hosting providers 
extending their support to this almost obsolete technology. 

Microsoft Expression Web replaced Microsoft FrontPage. Most of the activities in this 
module can also be done using Microsoft FrontPage. However, Microsoft FrontPage has 
a limited support for recent developments in web technologies such as CSS3, HTML5, 
etc. Yet, you can use form functionalities outlined in this module if your web hosting 
provider supports only FrontPage Server Extension. 

If you want to create a form for your Intranet or if your web hosting provider supports 
FrontPage Server Extensions, you can use procedure in this session to create the form, 
configure it to save the data in a database and later publish it to the remote computer. 

Web Server 

You can use the web server in-built with the operating system. Windows includes IIS 
(Internet Information Services) in both client and server operating systems. IIS in-built with 
client operating system such as Windows XP, Vista & 7 is usually sufficient for websites 
having few visitors. You can install IIS on Windows Vista & 7. Use the help file for detailed 
instructions. 

Note: FrontPage Server Extensions is not available in Vista / Windows 7 & Windows 
2008. You may download an evaluation copy of FrontPage Server Extensions (FPSE) 
from www.iis.net. Some web hosting providers still give support for FPSE and you will be 
able to publish using FPSE. 

http://www.iis.net.
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Creating Forms 

You can create forms and use additional functionalities of MEW. To create a form and 
store the details in a database, do the following: 

1) Select File > New > ASP and save this page as dform.asp.  

2) Insert a form and add the following:  

a) Insert Input (Text), for visitor’s name.  

b) Insert Input (Text), for visitor’s email address.  

c) Insert Drop-Down Box, for collecting visitor’s favorite color.  

d) Insert Input (Submit).  

Now your form should look similar to the one below: 

 
Figure-4.15 

You need to customize this form before it is displayed to the visitor. Now to customize 
the fields, do the following: 

3) Double-click on the first Input (Text) field. Type Name in Name:, click OK.  

4) Double-click on the second Input (Text) field. Type Email in Name:, click OK.  

5) Double-click on the drop-down box. Drop-down Box Properties dialog box appears.  

6) Since you are collecting details of visitor’s favorite color, you need to add dropdown 
values for visitor to select.  

a) Notice there is a default dropdown with null value (no value); you can remove 
that by selecting Remove.  

b) Click Add…, Type Red in Choice:, Click OK.  

c) Click Add…, Type Blue in Choice:, Click OK.  

d) Click Add…, Type Green in Choice:, Click OK.  

e) Now change the Name: (Select1) by replacing the text to Color.  
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Figure-4.16 

7) Click OK. 

Creating a Database 

To save the details collected from the form, you need to have a database with 
corresponding fields ready. MEW can create a database for you and link these fields to the 
database automatically. To create and link the database automatically, do the following: 

1) Right-click on the form, select Form Properties. The Form Properties dialog box is 
displayed.  

a) Select Send to database (Note: Requires FrontPage Server Extensions).  

b) Select Options…. The Options for Saving Results to Database dialog box 
appears (figure below).  

 
Figure-4.17 
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c) To create the database, select Create Database…. MEW automatically creates 
an Access database (only format supported for automatic creation). Click OK to 
close the popup.  

 
Figure-4.18 

2) Select Saved Fields tab. Note the fields are mapped from form to database 
automatically. Click OK twice  

 
Figure-4.19 

Now the form is ready but you need to publish the form to a server that supports 
FrontPage Server Extensions; otherwise this form will not work. Once publishing is 
complete, you can use the published URL to view the webpage. 

Publish the Form to a Website 

Note: Forms are published automatically along with other files in a website. 

1) Select Site > Publishing Settings….  
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2) Select Add….  

a) Type a friendly name in Name:  

b) Select FrontPage Server Extensions from Connection Type: dropdown menu  

c) Type the remote location, for example: www.example.com  

d) Type the credentials (Username and password) provided by the hosting provider.  

e) Click Add.  

3) Click OK.  

4) Select Site > Publish All Files to…NAME (IP address of the server or computer 
that supports FPSE).  

Note: Publishing may take some time. 

Viewing the Webpage 

Visitors can now view the website or webpage. When they click on the URL that takes 
them to the form, the form will appear. 

 
Figure-4.20 

Visitors can fill the form by entering the details and when they click submit, they will see a 
confirmation page similar to the one below: 

 
Figure-4.21 

http://www.example.com
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The database is stored in a special folder with the name fbdb; this folder is hidden for 
security purposes and is not accessible to visitors. 

You can open this database using your database software to view or modify information 
within this database. This could be useful when you want to collect all the email addresses 
and send a newsletter to visitors. 

Note: Use Windows Explorer to navigate to the folder that contains this website if you are 
using a web server within LAN; Access database is stored in a special folder named fpdb. 
If you are using MEW, then the access database can be retrieved from the fpdb folder in 
folder list view. 

Exercise: 

Perform the following activities till you are confident: 

S. No. Activities 

1. Create a detailed form for the following fields and configure it to save the details 
in a database. 
a)   First Name 
b) Last Name 
c)  Age 
d)   Email Address 

e)  Favorite Car (Include at least three different vendors, allow selection 
through Checkboxes – Single Selection) 

f) City (Create a list and display using a dropdown menu) 
g) State (Create a list and display using a dropdown menu) 
h) Pin Code 
i) Comments 

 

Assessment: 

Answer the following questions: 

Q1.  Explain the procedure to create a form that will be saved in a database.  

Q2.  Explain the purpose of FrontPage Server Extensions.  

 Fill in the blanks: 

1) ________ is the product was replaced by Microsoft Expression Web.  

2) Acronym for IIS ____________________________.  

3) Create Database option is available in _____________________ dialog box of form 
properties.  
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4.5  Publishing Webpages or Websites - I 
 Relevant Knowledge 

 Preparing for publishing 

 Before you publish a website, you need to verify the website’s functionality. Hyperlinks 
(internal & external) should be checked and replaced if necessary. Given here is a list of 
standard procedures to be followed prior to site publishing. 

 Examining Structure of a website 

 Create a visual diagram of hyperlinks of a website. This helps you understand the 
navigation structure or to trap any broken links. To view the structure of a website, do the 
following: 

1) Open the website  

2) Select View > Site > Hyperlinks. Notice the visual diagram (sample below).  

 
Figure-4.22 

3) You can further expand and understand the links to other pages. Select the plus 

symbol next to the link ( ). Notice the results displayed (figure 
below).  

 
Figure-4.23 
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Estimating Size of a website 

If you know the size occupied by files in a website, you can determine if you have 
sufficient web space (as allocated by an ISP) or even determine the time. Time taken to 
download before visitor can view the web page.. 

1) Select View > Site > Site Summary (figure below).  

 
Figure-4.24 

2) Notice the results displayed (sample below). Look at the list of items analyzed and 
given below Name, Count, Size and Description.  

 
Figure-4.25 

Removing slow pages 

You can now decide to remove items that may possibly slow down a page. 

1)   Select Site > Problems > Slow Pages (figure below) 
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Figure-4.26 

2) By default, HTML editor assumes and displays only the pages that take more than 30 
seconds to load. You can change the value to 3 seconds to list web pages that take 
more than 3 seconds to download. Select 3 Seconds from the dropdown (figure 
below).  

 
Figure-4.27 

3) Notice the results displayed (sample below).  

 
Figure-4.28 

HTML calculates based on two parameters; the amount of bandwidth and time taken to 
download within the set bandwidth. To modify this setting, do the following: 

1) Select Tools > Application Options…. Application Option dialog box will be 
displayed (figure below).  

 
Figure-4.29 
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2)   Select Reports View tab (figure below) 

 
Figure-4.30 

3) Notice the values of “Slow Pages” take at least and Assume connection speed of 
(indicated in kilobits per second)  

Note: This is not YOUR connection speed. This refers to the connection speed available at 
the web hosting end. 

DWT 

If you have used Dynamic Web Template to create the website, check for updates made 
to the template. Also you can update all the pages by selecting the Format > Dynamic 
Web Template > Update All Pages option to ensure all page layouts are up to date. 

Code Optimization 

Before you publish, you need to cleanup your web page for any unnecessary code that 
can result in reducing page size. This in turn will help in faster downloads. You can use the 
in-built optimizer tool to remove unnecessary code by: 

1) Select Tools > Optimize HTML…. The Optimize HTML dialog box appears.  

2) During development you may have left behind some code such as comments. These 
might have to be removed before you present the website to an audience. To do so, 
select All HTML Comments in Remove Comments section and then select OK. All 
the comments will be removed automatically.  

To optimize a web page, do the following: 

1) Open an existing page (at least 5-10 KB in size, record the size for comparison).  

2) Select all the items under Remove Components list.  

3) Click OK. Notice the difference in file size.  
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Figure-4.31 

Fixing Errors 

Before you publish the website, you need to verify if there are any pending issues. This 
helps you save time and unnecessary problems that may arise post publishing the 
website. 

To verify and fix (if there are any errors), do the following: 

1) Open the Website.  

2) Select Tools > Recalculate Hyperlinks. The Recalculate Hyperlink dialog box is 
displayed (figure below).  

 
Figure-4.32 

3)   Click Yes. If there are any issues, they will be automatically fixed. 
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Exercise: 

Perform the following activities till you are confident: 

S. No. Activities 

1. Create a visual diagram of any of the websites created earlier. Share it with your 
classmates.  
Optimize the HTML code in your website, remove all unnecessary code 

 

Assessment: 
 Answer the following questions: 

Q1.  Explain the procedure to create a visual diagram of a website.  

Q2.  Explain the purpose of Site Summary with an example.  

Q3.  Explain the purpose of Code Optimization with the procedure.  

Q4.  Explain the procedure to fix errors in a web page automatically.  

Fill in the blanks: 

1) Structure of website can be viewed using ____ option in ____ drop down menu of 
____ menu.  

2) Site summary is available in ____ dropdown menu of ____ menu.  

3) Optimize HTML is available in _____ menu.  

4) Recalculate Links is available in _____ menu.  

4.6  Publishing Webpages or Websites - II 

 Relevant Knowledge 

 Web Hosting 

 When you want others to see your content designed using HTML, you need to host the 
content in a web server to be viewed by the public. There are several free web hosting 
providers that provide free web space for your content. Though there may be restrictions 
on the total web space or advertisements posted within your website, the web space is 
usually sufficient for hosting small websites or practicing HTML! Use Google or other 
search engines to find a free web hosting provider. 

 Web hosting providers usually allow publishing through FTP Some web hosting providers 
allow other methods such as SFTP, WebDAV, etc. which you can use to upload your 
website. Some of them allow other methods such as SFTP (secure FTP), WebDAV, 
FrontPage Server Extensions, etc. and these are detailed usually in the page that displays 
various plans for comparison. 
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 For web pages created using HTML, you can use any provider that supports FTP. 

 Note: You can also use your own web server if you have a 24/7 active Internet connection 
and a static public IP address. Though you need to host the content in a web server for 
others to view, web pages made with HTML can be viewed from even a folder on your 
computer by sharing the folder in a LAN environment. Share the folder and provide the 
UNC path for others to view. 

 Publishing your website 

 Once you have created the website, you need to publish it to computers that will be 
available 24x7 for visitors to view. When you sign up with a hosting provider, generally, 
you will be given multiple options to publish the content such as FTP, WebDAV, 
FrontPage Server Extensions, etc. 

 To publish a website using FTP, do the following: 

1) Open the website that you need to publish.  

2) Select Site > Publishing Settings…. The Site Settings dialog box appears.  

3) Prior to publishing, you need to add details such as the destination computer’s IP 
addresses or domain name, settings and credentials. For example if you have signed 
up with a web hosting provider who has given you an IP address 192.168.1.200 and 
FTP as the method for publishing, do the following:  

a) Click Add…. The Connection Settings dialog box is displayed.  

b) Enter the following details:  

(i) Type a name in the Name: textbox (usually your domain name or 
destination computer name or IP address of the destination).  

(ii) Select FTP from the Connection Type: dropdown menu.  

(iii) Hosting providers will provide a path for publishing, for example: 
ftp.domainame.ext. Type the path in Location: textbox.  

(iv) Specify the folder where the content will be stored (Usually directory is 
auto-selected for websites, use this only if required).  

(v) Enter the username and password in Credentials: section. This will be 
used when you publish from the HTML editor. Generally multiple files are 
transferred simultaneously between HTML editor and destination resulting 
in faster transfers. Leave this setting as it is or contact hosting provider for 
this detail only if required.  

(vi) Click Add.  

c) Notice the change in the Publishing tab (figure below) indicating the remote site 
is added to the list.  
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Figure-4.33 

4)   Click OK. 

 Now MEW is ready with the remote site settings for publishing content. Whenever you 
want to publish (first time or periodic updates), do the following: 

5.   Select Site > Publish All files to [NAME]. 

Note that it may take a while for publishing the content depending on the number of 
files, the size of each file and the connection speed (Upload) you have. Once 
uploaded, MEW will indicate successful or failed publishing through a popup message 
similar to the one below. 

 
Figure-4.34 Failed Publishing 

To view the website, do the following: 

1) Open the web browser.  

2) Type the web server IP address, for example: 192.168.1.200.  

3) Select Go. Notice the website displayed in the web browser.  
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Web Packages 

Another method to take your website to a remote computer is by using the Web Package 
feature. You can use the Web Package feature to transfer contents of your entire website 
(preserving the structure) to a remote computer. This is useful when you want to send your 
website (including the complete structure) for being hosted from a remote computer or, if 
the existing structure is to be used for creating another website. 

To export existing website to a web package, do the following: 

a) Open the website  

b) Select Site > Export to Web Package…. (figure below).  

 
Figure-4.35 

3)   Export Web Package dialog box appears. 

4) You can select individual files or folders or, package the entire website. To package 
the entire website, 

a) Place the cursor at the top (image above). Click Add. Notice the entire website is 
added to the right pane.  

 
Figure-4.36 
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b) You can use a friendly name for this package. Select Properties…,and the Web 
Package Properties dialog box appears.  

c) You can enter company name, author, a suitable title for this package. External 
dependencies: has a list of external resources that this website uses. This is 
helpful when you are using any files, folder or links that need to be verified before 
sending the package to someone.  

(i) Enter a title in Title: textbox, for example: WEBPACKAGE.  

(ii) Enter a description in Description: textbox, for example: created using 
MEW.  

(iii) Enter your name in the Author: textbox  

(iv) Click OK.  

 
Figure-4.37 

5. Click OK.  

6. When prompted to save this Web Package, type a filename for example: 
MyFirstWebsite_DATE. Click Save. Notice the result displayed (figure below).  

7. Click OK.  

Navigate to the folder where you saved this web package and notice the entire website 
packed as a single file (figure below). 
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Figure-4.38 

Note: Replace the Date by specifying current date or a version number to easily identify 
the package. 

Importing Web Package 

If you want to import this web package on another computer, do the following: 

1) Create  a   New  Site  (Empty  Site),   name   this  website   for  example:  
MySecondWebsite.  

2) Select Site > Import > Import from Web Package… (figure below).  

 

Figure-4.39 

3) Browse and select the Web Package, select Open. The Import Web Package dialog 
box appears (figure below).  
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Figure-4.40 

4) You can either select individual files or folders, or the entire website. Click Import.  

5) Select Yes to All.  

6) Click OK.  

Now you can edit web pages within this website. Also you can keep a copy of the Web 
package as a backup for future use. 

Backup Websites 

It is a highly recommended practice to take periodic (daily, weekly, etc.) backups of 
websites either using special backup tools or publishing it to another internal source. 
Whenever you attempt to perform an update on a website, ensure you take a backup of 
the current site before touching it. 

If you only have HTML content (static web pages), use the following procedure to take a 
backup of the website: 

1) Go the location where your website is stored (default location is My Documents).  

2) Select the folder that has the complete website.  

3) Copy and paste it in another location such as a pen drive or to a folder on another 
computer.  
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Exercise: 

Perform the following activities till you are confident: 

S. No. Activities 

1. Compare different hosting providers using the worksheet below: 

Feature Provider 1 Provider 2 Provide 3 

ISP    

Monthly Price    

Setup Fee    

Disk Space    

Monthly Traffic    

Ads    

Languages    

ASP    

PHP    

Databases    

Access    

MySQL    

Microsoft SQL    

Email    

POP3/SMTP    

IMAP    

Web Mail    

Sub-Domains    

Templates    

FTP Access    

Statics IP Address    
 

 

Assessment: 

Answer the following questions: 

Q1.  Explain the procedure to add a remote host for publishing.  
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Q2.  Explain the procedure to publish a website with an example.  

Q3.  Explain the purpose of Web packages with an example.  

Q4.  Explain the procedure to backup a website with an example.  

 Fill in the blanks:  

1) Publishing Settings is available in ____ menu.  

2) Web package option should be accessed from _____ menu.  

3) Import from Web Package is available in _______ dropdown menu of ____ menu.  

4.7  Authoring Tools 
 Relevant Knowledge 

 You have learnt to work with Expression Web in earlier sessions. There are a variety of 
other web authoring tools available for use and most of them have similar functionality. 
Some of the popular authoring tools are discussed in this module. 

 KompoZer 

 KompoZer is an open source WYSIWYG HTML editor. KompoZer complies with the 
W3C's web standards. 

1) Download KompoZer from www.kompozer.com.  

2) Follow the on-screen instructions and complete installing the software.  

3) Select Start > Programs > KompoZer.  

 
Figure-4.41: KompoZer version 0.8b3 

Note: Screen grabs are from kompozer-0.8b3.en-US.win32 (Version). 

Now you have installed, create & save pages and view them using different web browsers. 

http://www.kompozer.com.
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To create a page using KompoZer, do the following: 

1) Select File > New…. The Create a new document or template dialog box is 
displayed (figure below).  

 
Figure-4.42 

2) Select A blank template, select Create.  

3) Type some content, select Source to view the source code.  

Use the help file (F1) to learn about using KompoZer. 

Dreamweaver 

Adobe Dreamweaver is another popular authoring tool used widely. Adobe Dreamweaver 
supports a variety of scripting languages such as JavaScript, VBScript, ASP.NET, PHP, 
etc. apart from standard support for HTML & CSS. 

1) Download Trial edition of Dreamweaver from adobe.com.  

2) Follow the on-screen instructions and complete installing the software.  

3) Select Start > Adobe > Dreamweaver.  

 
Figure-4.43: Adobe Dreamweaver CS6 

Use the help file (F1) to learn about using Adobe Dreamweaver. 
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Exercise: 

Perform the following activities till you are confident: 

S. No. Activities 

1. Download, install and work with Net Objects Fusion. 
 

Assessment:

Answer the following Questions 

Q1.  List any three web authoring tools.  

Q2.  Compare the features of at least two web authoring tools.  

 Fill in the blanks 

1) Examples of web authoring tools are (list three):  

a)  ______________________________________________________________.  

b)  ______________________________________________________________.  

c)  ______________________________________________________________. 

4.8  CSS Templates 

 Relevant Knowledge 

 Designing a good looking interface can be quite difficult at times as it requires creativity. 
Also you need to learn additional software to create such designs while focusing on 
delivering websites that are standard complaint. 

 When you design websites, you don’t have to design a web page from scratch. You can 
use templates that are available for free or a free to save time and efforts. Though you 
have learnt to create templates using HTML editors, you can still find and use creative 
designs for your websites. 

 CSS Templates 

 Instead of creating dull and boring websites, you can use templates that are available on 
the Internet. Popularly referred to as CSS Templates or XHTML/CSS Templates these 
templates look attractive while meeting certain standards. Following is a list of websites 
that offer such templates for your reference: 

  http://html5up.net  

  http://www.cssportal.com/css-templates/  

  www.freecsstemplates.org  

http://html5up.net
http://www.cssportal.com/css-templates/
http://www.freecsstemplates.org
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  www.free-css.com  

  www.templatemo.com  

  www.oswd.org  

  www.openwebdesign.org  

  and many more….  

To use a CSS template, do the following: 

1) Visit any of the website mentioned above (or use a search engine to locate one)  

2) Browse and select a template.  

3) Most website provides an entire site structure consisting of web page(s), style sheets 
and accompanying images as a single compressed package. Download the 
compressed file and unzip them to a folder. Also you may notice a link for live 
preview that allows you to view the template in action before downloading. Always 
check the design before you download.  

4) Once you download open the homepage. Homepage is usually titled with names as 
index.htm, default.htm or home.htm.  

Note: Some website may require you to sign up and even have certain terms and 
conditions. Check the website for requirements. 

Customizing Templates 

You can use a simple text editor to modify the template. However, if you find it difficult, you 
can use an HTML editor such as MEW. Also note that if the template is of a recent 
standard and if the HTML editor does not support that standard, entire template will 
appear distorted. Confirm if the HTML editor support the standard used in a template. 

To work with a template using MEW, do the following: 

1) Launch MEW.  

2) Create a New Site (always test the template in a new website).  

3) Copy all the files from the template folder. (or use import wizard).  

4) Paste in within the HTML editor (You may receive prompt for files to be overwritten, 
click yes).  

5) Open the Homepage (index or default.htm) (sample below). 

http://www.free-css.com
http://www.templatemo.com
http://www.oswd.org
http://www.openwebdesign.org
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Figure-4.44: Cool Web Template from CSSPORTAL.COM 

6) Customize the website.  

7) To view the source code, select View > Page > Code.  

Following is provided as a courtesy: 

CSS can also be used for developing attractive navigation menus (sample below). 

 
Figure-4.45; Sample Navigation Menus 

You can use CSS Tab designer (http://www.highdots.com/products/css-tab-designer/) to 
create navigation menus such as the ones above. 

http://www.highdots.com/products/css-tab-designer/)
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Exercise: 

Perform the following activities till you are confident: 

S. No. Activities 

1. Download a CSS template. Use this template as a design for the website 
created in earlier sessions. 

2. Download CSS Tab designer, create a navigation menu for a website. 

Assessment: 
 Answer the following Questions 

Q1.  Explain the purpose of using CSS templates.  

Q2.  Explain the procedure to download and use a template in an HTML editor.  

Fill in the blanks: 

1) List any three websites that offer free CSS templates (write complete URL).  

a)  ______________________________________________________________.  

b)  ______________________________________________________________.  

c)  ______________________________________________________________.  
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